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ABSTRACT 
 
 
Jacques, D., and J. Šimůnek, 2010. Notes  HP1– a software  for simulating variably-saturated 
water flow, heat transport, solute transport, and biogeochemistry in porous media. Version 2.2. 
SCK•CEN, Mol, Belgium, BLG-1068. 
 
HP1 is a comprehensive modeling tool in terms of processes and reactions for simulating 
reactive transport and biogeochemical processes in variably-saturated porous media. HP1 results 
from coupling the water and solute transport model HYDRUS-1D (Šimůnek et al., 2009a) and 
PHREEQC-2 (Parkhurst and Appelo, 1999). This note provides an overview of how to set up 
and execute a HP1 project using version 2.2.002 of HP1 and version 4.13 of the graphical user 
interface (GUI) of HYDRUS-1D. 
 
Version 2.2 of HP1 is embedded in the graphical interface of version 4.13 of HYDRUS-1D. The 
graphical user interface of HYDRUS-1D (H1D GUI) provides support to the HP1 code in order 
to  

• Manage HP1 projects using the Project Manager 
• Create new HP1 projects 
• Define the physical part (water flow, solute transport, heat transport) 
• Define the thermodynamic database 
• Define the components for the transport problem 
• Create the phreeqc.in input file 

o Define additions to the thermodynamic database  
o Define the composition of the initial and boundary solutions 
o Define the geochemical model 
o Define the output 

• Define the spatial distribution of the initial solutions and the temporal variation of the 
boundary solutions 

• Control output 
• Create templates to produce graphs with GNUPLOT 
• Run HP1 projects 
• Display selected numerical results 
• Display the help file 

 
A large part of this note are step-by-step instructions for selected examples involving mineral 
dissolution and precipitation, cation exchange, surface complexation and kinetic degradation 
networks. The implementation of variably-saturated flow conditions, changing boundary 
conditions, a layered soil profile or immobile water is also illustrated. 
 
 
 
 
 
 
 
Keywords 
HP1, reactive transport model, variably-saturated water flow, multicomponent solute transport, 
heat transport, biogeochemical processes, numerical model, HYDRUS-1D 
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1 Introduction 
 
HP1 is a comprehensive modeling tool in terms of processes and reactions for simulating 
reactive transport and biogeochemical processes in variably-saturated porous media. HP1 results 
from coupling the water and solute transport model HYDRUS-1D (Šimůnek et al., 2009a) and 
PHREEQC-2 (Parkhurst and Appelo, 1999). The combined code contains modules simulating 
(1) transient water flow in variably-saturated media, (2) transport of multiple components, (3) 
mixed equilibrium/kinetic biogeochemical reactions, and (4) heat transport. HP1 is a significant 
expansion of the individual HYDRUS-1D and PHREEQC programs by combining, and 
preserving, most of the features and capabilities of the two codes into a single numerical 
simulator. The code uses the Richards equation for variably-saturated flow and advection-
dispersion type equations for heat and solute transport. The program can also simulate a broad 
range of low-temperature biogeochemical reactions in water, the vadose zone and in ground 
water systems, including interactions with minerals, gases, exchangers, and sorption surfaces, 
based on thermodynamic equilibrium, kinetics, or mixed equilibrium-kinetic reactions. Various 
applications of HP1 were presented by Jacques and Šimůnek (2005), Jacques et al. (2006, 
2008a,b) and Šimůnek et al. (2006, 2009b). 
 
The first version of HP1 was released in November 2004 and is described in Jacques and 
Šimůnek (2005). The HP1 version 2.2.002 (released November 2009) is different with respect to 
following points, amongst others: 
 

• includes the computational module of version 4.0 of HYDRUS-1D 
• includes version 2.15.0-2697 of PHREEQC-2  
• is based on the source code of the HYDRUS-1D computational module rewritten in 

double precision 
• considers new components Total_O, Total_H, and Charge to allow simulations of redox 

processes and surface complexation 
• allows initial concentrations of components to be zero 
• defines solution compositions using solution composition numbers 
• is fully integrated in the graphical user interface of version 4.13 of HYDRUS-1D. 

 
This note provides an overview of how to set up and execute a HP1 project using version 2.2.002 
of HP1 and version 4.13 of the graphical user interface (GUI) of HYDRUS-1D. Chapter 2 
describes how an HP1 project is created, modified, and executed using GUI of HYDRUS-1D. 
Chapter 3 shows the implementation of the verification examples from the first manual (Jacques 
and Šimůnek, 2005) using version 2.2 of HP1. Chapter 4 describes a number of simple HP1 
projects and gives step-by-step instructions for their implementation using HP1. 
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2 Running HP1 from the HYDRUS-1D Graphical User Interface 
 
 
HP1, version 2.2.002 (released 31.10.2009), is embedded in version 4.13 of HYDRUS-1D 
(released 31.10.2009). The graphical user interface of HYDRUS-1D (H1D GUI) provides 
support to the HP1 code in order to  
 

• Manage HP1 projects using the Project Manager 
• Create new HP1 projects 
• Define the physical part (water flow, solute transport, heat transport) 
• Define the thermodynamic database 
• Define the components for the transport problem 
• Create the phreeqc.in input file 

o Define additions to the thermodynamic database  
o Define the composition of the initial and boundary solutions 
o Define the geochemical model 
o Define the output 

• Define the spatial distribution of the initial solutions and the temporal variation of the 
boundary solutions 

• Control output 
• Create templates to produce graphs with GNUPLOT 
• Run HP1 projects 
• Display selected numerical results 
• Display the help file 

 
In chapter 4, a number of step-by-step examples are given to illustrate the implementation and 
execution of a HP1 project using the H1D GUI. A short description of the provided support is 
given in this chapter. 
 

2.1 Differences Between Version 2.2.002 of HP1 (HYDRUS-1D Version 4.13) and Older 
Versions of HP1 and HYDRUS-1D 
 
Previous releases of HP1 were less embedded in the H1D GUI. No H1D GUI support was 
available for the geochemical part of HP1 projects of versions 1.0 and 2.0. Users had to prepare 
the HP1 input files species.in and phreeqc.in in an ASCII text editor or graphical user interface 
for PHREEQC and saved them in the project directory. In addition, a path.dat file was needed to 
identify the project directory. HP1 itself was executed from the Windows Explorer or the 
Command Prompt. Detailed instructions were given in the HP1 manual (Jacques and Šimůnek, 
2005).  
 
Starting with version 4.0 of HYDRUS-1D, the H1D GUI provided more support to HP1. One 
additional pre-processing menu allowed one to define the thermodynamic database and the 
components, i.e., the species.in file was automatically created by the H1D GUI. In addition, HP1 
projects were managed by the Project Manager and HP1 was executed from the H1D GUI. Later 
HYDRUS-1D versions (starting with version 4.06) also included an option to create a template 
of the phreeqc.in file, but editing of this file was still done outside of the H1D GUI. 
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In version 4.13 of HYDRUS-1D, the user can create a HP1 project using the H1D GUI without 
the need to use any external programs. The GUI of version 4.13 of HYDRUS-1D allows one to 
create a structured phreeqc.in file, which can be defined and/or modified using the H1D GUI 
(see paragraph 2.7). Note that projects created with previous versions of HP1 or HYDRUS-1D 
can be opened and executed with the GUI of version 4.13 of HYDRUS-1D. Furthermore, the 
user can still create the phreeqc.in file in an ASCII text editor or graphical user interface of 
PHREEQC. 
 
Another major difference between version 2.2.002 of HP1 and its older versions is the possibility 
to define the composition of the initial and boundary solutions in the phreeqc.in file. However, 
the spatial distribution of the initial solutions and the temporal variations of the boundary 
solutions are defined using the H1D GUI. In previous releases of HP1, initial solutions were 
defined only in the phreeqc.in file, whereas boundary solutions were defined via the H1D GUI. 
Version 2.2.002 of HP1 defines solutions in terms of solution composition numbers instead of 
concentrations. Solution composition numbers are used to define the spatial distribution of the 
initial solutions and the temporal variations of the boundary solutions in the H1D GUI. 
Concentrations of the components of a solution composition are defined in the phreeqc.in file. 
 

2.2 Manage HP1 Projects 
 
HP1 projects are managed in the same way as HYDRUS-1D projects using the Project Manager. 
The Project Manager is used to manage data of existing projects, and to locate, open, delete, 
copy, or rename projects. 
 

2.3 Create a New Project 
 
A new HP1 project is created using the button "New" in the Project Manager. After defining a 
name and a description of a project, the Main Process dialog window allows users to select the 
HP1 model from available solute transport models: 
 

 
 

2.4 Define the Physical Part of a Project 
 
The physical part of a HP1 project (water flow, solute transport and heat transport) is defined 
using the H1D GUI in the same way as for HYDRUS-1D projects. Depending on the choice of 
selected processes, models, and options, a number of pre-processing menus will be displayed. 
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Options, which are not available in HP1, are disabled in the H1D GUI. The main difference 
between HYDRUS-1D and HP1 projects is that the Solute Transport - Solution Reaction 
Parameters dialog window, which is not needed in HP1, is replaced by the HP1 Definitions 
dialog window. 
 

2.5 Define the Thermodynamic Database 
 
The definition of the thermodynamic database is in the HP1 Components and Database 
Pathway dialog window. Using the "Browse" button, it is possible to select a thermodynamic 
database. Note that the format of the thermodynamic data in the database must follow the 
conventions of PHREEQC (see PHREEQC-2 manual, Parkhurst and Appelo, 1999). A number 
of thermodynamic databases is installed with HYDRUS-1D. 
 

2.6 Define Components 
 
The element names of components are defined in the HP1 Components and Database Pathway 
dialog window. The number of components is specified in the Solute Transport - General 
Information dialog window. 

Components must start with a capital letter and must be present as element_name in the 
SOLUTION_MASTER_SPECIES keyword block of the thermodynamic database or in the 
phreeqc.in input file (which can be defined in the H1D GUI in the editor Addition to the 
thermodynamic database of the HP1 Definitions dialog window, see paragraph 2.7.4). Three 
special components are: 

• Total_O: a component related to O(-2) that sums up all O(-2) in the aqueous species 
except in H2O. It is recommended to include this component in each project. 

• Total_H: a component related to H(1) that sums up all H(1) in the aqueous species 
except in H2O. It is recommended to include this component in each project. 

• Charge: a component related to the charge of the aqueous phase. This component should 
be used when a non-electrical surface complexation model involving charged species is 
used. In the non-electrical surface complexation model, positive or negative charges on 
the surface are not compensated. Therefore the aqueous phase also has a negative or 
positive charge. Note that the complete system (surface + aqueous phase) is charge 
balanced. 

Each redox state of redox-sensitive components has to be defined as a component. Without a 
valence state, a redox-sensitive component will not be recognized. Thus, while Fe is not a valid 
component, Fe(2) and Fe(3) are. HP1 will issue a warning when a component is present in the 
aqueous phase during the geochemical calculations (with PHREEQC), but is not transported 
(i.e., when it is not defined as a component in the HP1 Components and Database Pathway 
dialog windows). 
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2.7 Create the phreeqc.in File 
 

2.7.1 Options to create and modify the phreeqc.in file 
 
The H1D GUI allows for three options to create the phreeqc.in file: 
 

• Create and modify the phreeqc.in file using the H1D GUI  
• Create the phreeqc.in file using the H1D GUI and modify it using an ASCII text editor or 

the PHREEQC graphical user interface 
• Create and modify the phreeqc.in file using an ASCII text editor or the PHREEQC 

graphical user interface 
 
The selection of this option is done in the HP1 Components and Database Pathway dialog 
window. 
 

 
 
 
 
When the option "Create PHREEQC.IN file using HYDRUS GUI" is not selected, the 
phreeqc.in file has to be created and modified outside the H1D GUI: 
 

• When the option "In Concentrations" is selected, the approach of specifying initial and 
boundary conditions as described in Jacques and Šimůnek (2005) has to be followed. 
This implies that: 

• the phreeqc.in file has to be created and modified outside the H1D GUI, 
• the composition of the boundary solutions has to be defined within the H1D GUI  
• the initial conditions and their spatial distributions have to be defined in the 

phreeqc.in file 
 

• When the option "In Solution Compositions" is selected without the option "Create 
PHREEQC.IN file using HYDRUS GUI", only solution composition numbers are 
defined in the H1D GUI. Therefore: 

• the phreeqc.in file has to be created and modified outside the H1D GUI  
• the composition of the  boundary solutions has to be defined in phreeqc.in using 

specific solution composition numbers 
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• the temporal variation of the boundary solution is defined in the H1D GUI by 
specifying the solution composition number corresponding to the solution 
composition number defined in phreeqc.in 

• the initial conditions and their spatial distribution have to be defined in the 
phreeqc.in file 

 
When the option "In Solution Composition" is selected together with the option "Create 
PHREEQC.IN file using HYDRUS GUI", then: 
 

• the phreeqc.in file is a structured file, which is created and can be modified using the 
HP1 Definitions dialog window and the H1D GUI. 

• the composition of the boundary solutions has to be defined in phreeqc.in using specific 
solution composition numbers 

• the temporal variation of the boundary solutions is defined in the H1D GUI by specifying 
the solution composition number corresponding to the solution composition number 
defined in phreeqc.in 

• the initial solutions are defined in the phreeqc.in file using specific solution composition 
numbers 

• the spatial distribution of the initial solutions is defined in the H1D GUI by specifying the 
solution composition number in the soil profile corresponding to the solution composition 
number defined in phreeqc.in 

 
Note that the phreeqc.in file is automatically updated when changes are made in initial settings 
in the H1D GUI (e.g., different material distributions, initial water contents, or spatial 
distribution of initial solutions), but only for initial distribution of the solutions and the initial 
water content. 
 
Alternatively, the phreeqc.in file can be first created and saved using the H1D GUI when the 
option "Create PHREEQC.IN file using HYDRUS GUI" is selected. The option “Create 
PHREEQC.IN file using HYDRUS GUI" can then be deselected. The phreeqc.in file will not be 
automatically updated any longer by the H1D GUI and can be modified outside the H1D GUI. 
 

2.7.2 Structured phreeqc.in File 
 

The structured phreeqc.in file consists of seven blocks. Each block starts with the identifier 
#HP1BEGIN and ends with the identifier #HP1END. The seven blocks are written in this 
sequence: 

GENERAL This block contains general information, such as the path to the 
database, the project folder, a number of soil layers and 
corresponding node numbers, and the project title. All this 
information, except the last one, is saved as comments (i.e., with 
the # sign in front). This block is automatically updated by the 
HYDRUS GUI when the project is saved. 

DATABASE This block contains additions to the thermodynamic database 
typically defined using the following PHREEQC data blocks: 
SOLUTION_MASTER_SPECIES, SOLUTION_SPECIES, 
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PHASES, EXCHANGE_MASTER_SPECIES, 
EXCHANGE_SPECIES, SURFACE_MASTER_SPECIES, 
SURFACE_SPECIES and RATES. The content is defined in the 
editor Additions to Thermodynamic Database of the Solute 
Transort – HP1 Definition dialog window. 

OUTPUT This block consists of two parts. The first part starts with the 
PHREEQC keyword SELECTED_OUTPUT, followed by the 
information defined in the HP1 – Print and Punch Controls 
dialog window. This block is automatically updated by the 
HYDRUS GUI when the project is saved. The second part contains 
additional specifications to be written to the output files and is 
typically defined using the following PHREEQC data blocks: 
USER_PUNCH, USER_PRINT, and SELECTED_OUTPUT. The 
content is defined in the editor Additional Output of the Solute 
Transport – HP1 Definitions dialog window. 

SOLUTIONDEFINITION This block contains the definitions of the initial solutions and 
boundary solutions. The latter is only read from the phreeqc.in 
input file when the radio button In Solution Compositions in the 
Solute Transport – HP1 Components dialog window is selected. 
The content is defined in the editor Definitions of Solution 
Composition of the Solute Transport – HP1 Definitions dialog 
window. 

INITIAL  This block contains definitions of the initial solutions for each 
node. The block starts with an END keyword. For each node, both 
for the mobile and immobile aqueous phases, a MIX – SAVE 
statement is included with the following format: MIX 
solution_number; solution_composition water_content; SAVE 
SOLUTION solution_number; END, where solution_number is the 
solution number (equal to the node number for the mobile aqueous 
phase and to the node number + N for the immobile aqueous phase, 
where N is the number of nodes), solution_composition is the 
solution composition number as defined in the H1D GUI (Soil 
Profile – Summary Soil Profile – Summary dialog window), and 
water_content is the initial water content as defined in the H1D 
GUI (either as the initial water content or calculated from the initial 
pressure head and soil retention parameters). This block is 
automatically updated by the H1D GUI when the project is saved. 

GEOCHEMICAL  This block contains the definition of the geochemical model 
typically using the following PHREEQC data blocks: 
EQUILIBRIUM_PHASES, EXCHANGE, SURFACE, 
KINETICS, and SOLID_SOLUTIONS. The content is defined in 
the editor Geochemical Model of the Solute Transport – HP1 
Definitions dialog window. 

TRANSPORT  This block contains the keywords END, followed by PRINT with 
the identifiers –reset and -warnings as defined in the HP1 – Print 



 

 

8 

and Punch Controls dialog window, and the keyword 
TRANSPORT with –cells to define the number of nodes 
(information from the H1D GUI) and print-, punch- and dump- 
related identifiers as defined in the HP1 – Print and Punch 
Controls dialog window. All relevant identifiers for the 
TRANSPORT keyword are defined using the H1D GUI. This block 
is automatically updated by the H1D GUI when the project is 
saved. 

 

2.7.3 Modify the Structured phreeqc.in File 
 
The user can modify the phreeqc.in file using the four editors in the HP1 definitions dialog 
window: 
 

 
 
 

2.7.4  Define Additions to the Thermodynamic Database 
 
Additional thermodynamic definitions are added to the phreeqc.in file (not to the thermodynamic 
database file) using the editor Additions to Thermodynamic Database in the HP1 Definitions 
dialog window. Typical PHREEQC data blocks used here are: 

• SOLUTION_MASTER_SPECIES 
• SOLUTION_SPECIES 
• PHASES 
• EXCHANGE_MASTER_SPECIES 
• EXCHANGE_SPECIES 
• SURFACE_MASTER_SPECIES 
• SURFACE_SPECIES 
• RATES 

 
Users are referred to the PHREEQC-2 manual (Parkhurst and Appelo, 1999) for the conventions 
used for the input of thermodynamic data. 
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2.7.5 Define the Composition of Initial and Boundary Solutions 
 
Compositions of the initial and boundary solutions are defined using the editor Definitions of 
Solution Compositions in the HP1 Definitions dialog window. Typical PHREEQC data blocks 
are SOLUTION and SOLUTION_SPREAD. The solution number refers to the solution 
composition numbers of the initial and boundary solutions defined in the H1D GUI.  
 
The following solution composition numbering is used throughout this manual: 
 

• Numbers 1001 – 2000: to define initial solutions for the mobile water phase.  
• Numbers 2001 – 3000: to define initial solutions for the immobile water phase. 
• Numbers 3001 – 4000: to define upper boundary solutions 
• Numbers 4001 – 5000: to define lower boundary solutions 

 
The link between the initial solution composition numbers and the spatial distribution is defined 
in the Soil Profile – Summary dialog window. 
 
The link between the boundary solution composition numbers and the boundary conditions is 
defined in the Solute Transport – Boundary condition dialog window or the Variable 
Boundary Conditions dialog window. 
 

2.7.6 Define the Geochemical Model 
 
The definition of the geochemical model is done using the editor Geochemical Model in the HP1 
Definitions dialog window and it typically involves the following PHREEQC data blocks: 

• EXCHANGE 
• EQUILIBRIUM_PHASES 
• SURFACE 
• KINETICS 
• SOLID_SOLUTIONS 

 
There is currently no automatic link between the definition of different materials in the H1D GUI 
and the chemical heterogeneity in the geochemical model. Thus, numbering of geochemical 
keywords must refer to the node numbers. If the material distribution is changed in the H1D 
GUI, the user must change the numbering of the geochemical model using the editor 
Geochemcial Model in the HP1 Definitions dialog window. 
 
When the user defines a material distribution in the H1D GUI, a template of it with 
corresponding node numbers is incorporated in the text editor when he clicks the "Add" button 
of the corresponding geochemical model. Note that this template is not automatically updated 
when the material distribution or number of nodes are changed. 
 
The numbering of the geochemical model is 

• 1 to number of nodes for the mobile water phase 
• number of nodes + 1  to 2 * number of nodes for the immobile water phase 
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2.7.7 Define the Output 
 
The user can define additional output using the editor Additional output in the HP1 Definitions 
dialog window by using the PHREEQC data blocks SELECTED_OUTPUT and USER_PUNCH. 
Depending on the options selected in the HP1 – Print and Punch Control dialog window, a 
number of output files is created. 
 
HP1 specific output files have the same structure as the "selected output" files of PHREEQC. 
They are tab-delineated and can be opened using ASCII text editors or EXCELL. 
 

2.8 Define the Spatial Distribution of the Initial Solutions and Temporal VariationS of 
the Boundary Solutions 
 
The following methods are available to define the spatial distribution of the initial solutions: 
 

• Using the Soil Profile – Graphical Editor module. After selecting   
 

Condition -> Initial Conditions -> Concentration 
Concentration number: 1 
Edit Condition 

 
a range of nodes can be selected and a solution composition number can be assigned for 
the mobile water phase. To assign a solution composition number for the immobile water 
phase: 

 
Condition -> Initial Conditions -> Sorbed Concentration 
Concentration number: 1 
Edit Condition 

 
• Via the Soil Profile – Summary dialog window. Solution composition numbers are 

defined in the column "Cnc. Comp." for the mobile water phase and in the column "Im. 
C. Comp." for the immobile water phase. 

 
In case of a constant boundary condition, the boundary condition is assigned in the Solute 
Transport – Boundary Conditions dialog window by specifying the solution composition 
number. Solution composition numbers 3001 and 4001 are specified in the example below:  
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In case of time variable boundary conditions, the boundary condition is assigned in the Variable 
Boundary Conditions dialog window. For example: 
 

 
 
 

2.9 Control Output 
 
The H1D GUI allows users to specify times and locations, for which output variables are to be 
printed into output files. This is defined in the HP1 Print and Punch Controls dialog window: 
 

 
 

2.9.1 Punch Times and Locations 
 
The Punch Times and Locations section defines how variables selected by in the PHREEQC data 
blocks SELECTED_OUTPUT and USER_PUNCH are to be printed. Depending on the choice of 
the user, data is written in a series of ASCII files with tab-delimited columns.  
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If the option "Controlled by HYDRUS" is checked, punch times and locations (i.e., observation 
nodes) are defined using the H1D GUI: 
 

• Time series at observation points:  
o Locations of the observation points are defined in the "Soil Profile – Graphical 

Editor" module, which can be selected from the pre-processing menu: 
 

Conditions -> Observation Points  
Insert 

 
o Print times are defined in the Print Times dialog window: 

 
Print Options -> T-level information; and/or 
Print Options -> Print at Regular Time Interval 

 
• Profiles at specific times: 

o Print times are defined in the Print Times dialog window: 
 

Print Times 
Number of Print Times 
Select Print Times 

 
Depending on the options selected by the user, a number of output files is created: 
 

• "Observ. Nodes Printed to Different Files": Time series for different observation nodes 
are printed into different files 

• "Mobile and Immobile Cells in Different Files": Time series and profile data for the 
mobile and immobile water phases are printed into different files. 

 
Following files are created: 
 

• If both options are unchecked 
o Obs_node_chem.out for the time series 
o Node_inf_chem.out for the profile data 

• If "Observ. Nodes Printed to Different Files" is checked: 
o Obs_node_chemx.out for the time series for the observation point with a node 

number x. One file is created for each observation point 
o Node_inf_chem.out for the profile data 

• If "Mobile and Immobile Cells in Different Files" is checked: 
o Obs_node_chem_m.out for the time series of the mobile water phase 
o Obs_node_chem_im.out for the time series of the immobile water phase 
o Node_inf_chem_m.out for the profile data of the mobile water phase 
o Node_inf_chem_im.out for the profile data of the immobile water phase 

• If both options are checked 
o Obs_node_chemxm.out for the time series of the mobile water phase for the 

observation point with a node number x. One file is created for each observation 
point. 

o Obs_node_chemxim.out for the time series of the immobile water phase for the 
observation point with a node number x. One file is created for each observation 
point. 
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o Node_inf_chem_m.out for the profile data of the mobile water phase 
o Node_inf_chem_im.out for the profile data of the immobile water phase 

 
If "controlled by PHREEQC" is checked, the user can defined a series of punch cells (e.g., "1 2 5 
25", or "1-5 25") and a punch frequency. The punch frequency indicates the number of time 
steps between printing of data. All data are printed in a single output file. The user specifies the 
name of the output file in the File name text box of the Selected Output section. 
 

2.9.2 Selected Output 
 
This submenu allows specifying a number of output variables to be written to the selected output 
files. Additional variables can be specified using the PHREEQC data blocks 
SELECTED_OUTPUT and USER_PUNCH in the editor Additional Output of the HP1 
Definitions dialog window. It is not needed to specify a file name in the editor Additional 
Output. 
 

2.9.3 Print Options 
 
This submenu allows specifying the print times and locations to write geochemical information 
to the standard PHREEQC text output file phreeqc.out. 
 
Print locations can be linked to the HYDRUS observation points specified in the Soil Profile – 
Graphical Editor module using the option "HYDRUS Observation Nodes". Alternatively, a 
series of node numbers can be defined. 
 
Print times can be linked to the specified print options in the Print Options dialog window. 
Alternatively, a print frequency can be defined. 
 

2.9.4 PHREEQC Dump 
 
The dump files created by PHREEQC give a complete geochemical state for all nodes at a given 
time step. It is formatted as a PHREEQC input file and can thus be used to restart a HP1 
calculation after failure (some adaptations may be necessary). More information is given in the 
PHREEQC manual. 
 
There are options to link the times when a dump file should be created to the print times defined 
in the Print Options dialog window. 
 

2.9.5 HP1 Output Files with Geochemical Information 
 

Following output files are created by HP1 (in addition to the output files created by the regular 
routines of the HYDRUS program): 

• Phreeqc.out: the standard text output file of PHREEQC. This file contains information on 
different calculations steps, warnings, and a full description of the geochemical 
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calculations. The amount of information written to the phreeqc.out file can be controlled 
using the PHREEQC data block PRINT. Specific user-defined output in the phreeqc.out 
output file can be defined using the PHREEQC data block USER_PRINT. When the 
radio button No Printing in phreeqc.out is selected in the HP1 – Print and Punch 
Controls dialog window, the output is generated only during the initialization of the 
project (i.e., for the PHREEQC commands defined in the blocks GENERAL to 
GEOCHEMICAL in the Phreeqc.in Input File), but not during the TRANSPORT 
calculations. This option is recommended because, otherwise, an enormous amount of 
output will be generated during the transport calculations. The running time will also 
increase when all the geochemical information is written into phreeqc.out. 

• Selected output file (xxx.hse): The name of the selected output file is defined in the File 
Name text box of the HP1 – Print and Punch Controls dialog window. Information, 
which is printed into this file is: status, solution number, time, depth, options selected in 
the Selected Output section of the HP1 – Print and Punch Controls dialog window, and 
options the user defines using the PHREEQC data block SELECTED_OUTPUT in the 
text editor Additional Output of the Solute Transport – HP1 Definitions dialog window. 
When the user selects only the option that punch times and locations are controlled by 
HYDRUS (see the HP1 – Print and Punch Controls dialog window), the selected 
output file contains only information for the initial PHREEQC calculations, i.e., the 
PHREEQC calculations before the TRANSPORT keyword. Geochemical information 
during the transport calculations is saved in output files described below. When the user 
selects the option that punch times and locations are controlled by PHREEQC (see the 
HP1 – Print and Punch Controls dialog window), geochemical information during the 
transport calculations is also printed in the selected output file for the locations and times 
defined in the text editors Punch Cells and Punch Frequency in the HP1 – Print 
Information dialog window. 

• Obs_node_chem.out, obs_node_chemx.out, obs_nod_chem_m.out, 
obs_nod_chem_im.out, obs_node_chem_mx.out, and obs_node_chem_imx.out: These are 
files containing time series of the geochemical variables at the observation nodes defined 
in the Soil Profile – Graphical Editor module. The content is identical to the selected 
output file, but information is only written during the transport calculations. The exact 
names of the files created depend on the options the user selected in the HP1 – Print and 
Punch Controls dialog window (see paragraph 2.9.1).  

• Nod_inf_chem.out, nod_inf_chem_m.out, and nod_inf_chem_im.out: These are files 
containing profile information of the geochemical variables for the Print Times defined in 
the Print Information dialog window. The content is identical to the selected output file, 
but information is only written during the transport calculations. The exact names of the 
files created depend on the options the user selected in the HP1 – Print and Punch 
Controls dialog window (see paragraph 2.9.1).  

• Phreeqc.dmp: This is a file which contains complete geochemical conditions at a specific 
time (as defined in the HP1 – Print and Punch Controls dialog window). This file can 
be used to start a new simulation. Note that the dump file was created for transport 
simulations with PHREEQC, and thus some modifications for the use with HP1 may be 
needed. 

• Phreeqc.log: This file contains information about each calculation. The information 
includes the number of iterations in revising the initial estimates of the master unknowns, 
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the number of Newton-Raphson iterations, and the iteration at which any infeasible 
solution was encountered while solving the system of nonlinear equations (An infeasible 
solution occurs if no solution to the equality and inequality constraints can be found.). At 
each iteration, the identity of any species that exceeds 30 mol (an unreasonably large 
number) is written to the log file and noted as an "overflow". Any basis switches are 
noted in the log file. The phreeqc.log file is created when the identifier –logfile is true 
under the PHREEQC data block KNOBS. 

2.10 Create Templates to Produce Graphs with GNUPLOT 
 
If the options "Observ. Nodes Printed to Different Files" and "Mobile and Immobile Cells in 
Different Files" are checked in the HP1 - Print and Punch Controls dialog window, the user 
can also check the option "Make GNUplot Tempates" in the same dialog window. HP1 creates a 
series of templates *.plt, two for each variable printed in the selected output files. These 
variables are specified in the Selected Output section of the HP1 - Print and Punch Controls 
dialog window and using the PHREEQC data block SELECTED_OUTPUT and USER_PUNCH in 
phreeqc.in or the editor Additional output in the HP1 Definitions dialog window. 
 
The name of the template file can consists of up to four parts, separated by an underscore: 

• pd or ts: These two template files are made for each variable. 
o The file, which begins with "pd", contains information to produce depth profiles 

of a particular variable at selected times. The times are specified as the Print 
Times in the Print Information dialog window.  

o The file, which begins with "ts", contains information to produces time series of a 
particular variable at selected observation points. The observation points are 
defined in the Soil Profile – Graphical Editor module. The times are defined in 
the Print Options of the Print Information dialog window. 

• Type of a variable: 
o Name of the variable: pH, pe, Temperature, Total alkalinity, Ionic strength, mass 

of water, Electrical balance, Percent error on electrical balance,  
o Type of the variable: 

 tot: total aqueous concentration (-totals in SELECTED_OUTPUT) 
 mol: molality (-molalities in SELECTED_OUTPUT) 
 act: activity (-activities in SELECTED_OUTPUT) 
 eq: amount of an equilibrium phase [mol/1000 cm³] (-equilibrium_phases 

in SELECTED_OUTPUT) 
 d_eq: change in amount of an equilibrium phase [mol/1000 cm³/time] unit 

(-equilibruim_phases in SELECTED_OUTPUT)  
 si: saturation index of an equilibrium phase (-saturation_indices in 
SELECTED_OUTPUT) 

 kin: amount of a kinetic reactant [mol/1000 cm³] (-kinetics in 
SELECTED_OUTPUT) 

 d_kin: change in amount of a kinetic reactant [mol/1000 cm³/time] (-
kinetics in SELECTED_OUTPUT) 

 ss: amount of a component in a solid solution [mol/1000 cm³] (-
solid_solutioins in SELECTED_OUTPUT) 

 iso: isotopes (-isotopes in SELECTED_OUTPUT) 
 calc: value of a calculated variable (-calculate_value in 
SELECTED_OUTPUT) 
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 user: values of the punch variables in the PHREEQC USER_PUNCH data 
block 

• Name of a variable (e.g., Ca in case –totals, or Ca+2 in case of –molalities) 
• m, im: m indicates values in the mobile water phase, im indicates values in the immobile 

water phase. 
 
A specific format of the headings in the PHREEQC data block USER_PUNCH can be used for 
appropriate definitions of texts at axes in the GNUPLOT templates. An underscore (“_”) is 
translated to a space and the symbol “@” separates the name of a variable from its unit. Thus, for 
the heading Total_Cd@µmol_per_kgw, the corresponding text in the GNUPLOT template is 
"Total Cd (µmol per kgw)". 
 
To view a plot, the GNUPLOT code should be installed on the computer. GNUPLOT is freeware 
software and can be downloaded from http://www.gnuplot.info/. 
 
After opening the window version of GNUPLOT, wgnuplot.exe, a plot can be directly generated 
by: 
 
 File -> Open 
 Browse to project directory 
 Open the template file of interest (*.plt) 
 
The figure can be adapted using line commands (see tutorials of GNUPLOT on the internet). 
After adaptations, the command lines can be saved to be used later on.  
 

2.11 Running a HP1 Project 
 
A HP1 project is saved and executed as a regular HYDRUS-1D project. After saving input data, 
all output files *.out are deleted. Output files with other extensions are not deleted. Note that the 
*.plt files are overwritten whenever input data are saved, as long as the option "Make GNUplot 
Templates" in the HP1 Print and Punch Controls dialog window is checked. 
 

2.12 Looking at Selected Numerical Results 
 
After execution of the HP1 code, output variables related to the physical part of the project can 
be inspected using the post-processing menus in the H1D GUI. The post-processing menu shows 
only the total concentration of the components. Concentrations are always in moles/1000 cm³. 
 
The user has to go to the project directory to look at the output of the geochemical variables. Part 
of the data can be visualized using GNUPLOT if GNUPLOT templates are generated. 
 

2.13  Help File 
 
The help file of the H1D GUI contains some information on HP1 and on the PHREEQC 
keywords, identifiers and BASIC statements for the phreeqc.in file. Only some basic information 
is included in the help file. The user is referred to the PHREEQC manual (Parkhurst and Appelo, 
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1999) for a full description of the PHREEQC keywords, identifiers and BASIC statements. Not 
all keywords are yet documented in the help file of version 4.13 of HYDRUS-1D. 
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3 Examples Installed with HP1 
 
These examples are the verification examples that were described in the manual of HP1, version 
1.0 (Jacques and Šimůnek, 2005). Details on these examples and the corresponding HP1 input 
are given in Jacques and Šimůnek (2005) and are not repeated here. Graphs given below were 
generated using the GNUPLOT software, based on the GNUPLOT templates generated with 
HP11. Note that some figures differ from those in the manual of HP1, version 1.0 (Jacques and 
Šimůnek, 2005), because the temperature in the simulations reported here was 25ºC, whereas it 
was 20ºC in the manual of version 1.0 of HP1. 
 

3.1 EqCl: Physical Equilibrium Transport of Cl for Steady-State Flow Conditions2 
 
This problem simulates the transport of chloride (a geochemically inert tracer) during saturated 
steady-state flow in a 20-cm long soil column. The saturated hydraulic conductivity Ks is 1 cm d-

1 and the saturated water content is 0.5 cm3cm-3. The dispersivity is 8 cm. Initially, no Cl is 
present in the soil column. The Cl concentration in the percolating water is 1 mmol/kgw. 
Simulated time series of Cl at two depths are shown in Figure 1. 

3.2 NEQCL: Physical Nonequilibrium Transport of Cl for Steady-State Flow 
Conditions 3 
 
This problem simulates the transport of chloride (a geochemically inert tracer) during saturated 
steady-state flow in a 20-cm long soil column. The saturated hydraulic conductivity Ks is 1 cm d-

1 and the saturated water content is 0.5 cm3cm-3. The dispersivity is 8 cm; the immobile water 
content (θim) is 0.1 cm3cm-3; and the first-order exchange coefficient (ω) is 0.01 d-1. Initially, no 
Cl is present in the soil column. The Cl concentration in the percolating water is 1 mmol/kgw. 
Simulated time series of Cl at two depths are shown in Figure 2. 
                                                 
1 Small changes in the GNUPLOT graphs presented here were made compared to the HP1 generated templates in 
order to improve the layout for this report. Changes are related only to line colors, thickness, and text sizes. These 
changes are easily done using the command line definition of GNUPLOT. 
2 Verification problem 1 in Jacques and Šimůnek (2005). 
3 Verification problem 1 in Jacques and Šimůnek (2005). 
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Figure 1 - Time series of Cl at two depths for the example EQCL. 
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3.3 TRANSCL: Physical Nonequilibrium Transport of Chloride for Transient Flow 
Conditions4 
 
This problem simulates the transport of chloride through a 1-m deep soil profile subject to a 
transient upper boundary condition given by daily values of precipitation and evaporation over a 
300-d period. Physical nonequilibrium (i.e., the presence of immobile water in the soil profile) 
was considered in this problem. The soil hydraulic properties are typical for a loamy soil (θr = 
0.078 cm3cm-3, θs = 0.43 cm3cm-3, α = 0.036 cm-1, n = 1.56, and Ks = 24.96 cm d-1, from Carsel 
and Parish, 1988). Solute transport parameters were as follows: a dispersivity DL of 8 cm, an 
immobile water content θim of 0.05 cm3cm-3, and a first-order exchange coefficient ω of 0.0125 
d-1. Precipitation and evaporation rates were typical for the Campine region in Belgium. The soil 
profile was discretized into 100 elements of 1 cm each. Chloride was applied during the first 53 
days of the simulation with a concentration of 0.1 mmol l-1. Time series of Cl outflow 
concentrations and concentration profiles are shown in Figure 3 and Figure 4, respectively. 
 

                                                 
4 Similar to Verification problem 2 in Jacques and Šimůnek (2005). 
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Figure 2 - Time series of Cl at two depths for the example NEQCL. 
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3.4 STADS: Transport of nonlinearly adsorbed contaminant for steady-state flow 
conditions5 
 
In this problem, saturated steady-state water flow and single-component transport of a 
nonlinearly adsorbing contaminant (Pola) through a soil column of 1-m length for a period of 
1000 d are considered. Transport and reactive parameters are as followed: the saturated hydraulic 
conductivity Ks = 1 cm d-1, the saturated water content = 0.5 cm3 cm-3, the dispersivity = 1 cm, 
the bulk density = 1.5 g cm-³, the Freundlich distribution coefficient = 5 cm³ g-1, and the 
Freundlich exponent is 0.8. Initially, no contaminant is present in the soil. The contaminant 
concentration in the percolating water is 1 mol/kgw. Profiles of Pola concentrations are shown in 
Figure 5. 
 
                                                 
5 Verification problem 3 in Jacques and Šimůnek (2005). 
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Figure 3 – Time series of Cl concentrations in the mobile phase at four 
depths for the example TRANSCL. 
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Figure 4 – Profile plots of Cl concentrations in the mobile phase (left) and immobile phase (right) at 
selected times for the example TRANSCL. 
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3.5 STDECAY: Transport of Nonlinearly Adsorbing Contaminant with First-Order 
Decay for Steady-State Flow Conditions6 
 
In this problem, saturated steady-state water flow and single-component transport of a 
nonlinearly adsorbing, first-order decaying contaminant (Pola) through a soil column of 1-m 
length for a period of 1000 d are considered. Transport and reactive parameters are as followed: 
the saturated hydraulic conductivity Ks = 1 cm d-1, the saturated water content = 0.5 cm3 cm-3, 
the dispersivity = 1 cm, the bulk density = 1.5 g cm-³, the Freundlich distribution coefficient = 5 
cm³ g-1, the Freundlich exponent is 0.8, and the first-order decay constant is 0.02 d-1.7 Initially, 
no contaminant is present in the soil. The contaminant concentration in the percolating water is 1 
mol/kgw. Profiles of Pola concentrations are shown in Figure 6. 
 

                                                 
6 Verification problem 4 in Jacques and Šimůnek (2005). 
7 Note that in the manual of HP1 version 1.0 (Jacques and Simunek, 2005), the decay coefficient was wrongly 
printed as 0.2 d-1 instead of 0.02 d-1. 
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Figure 5 – Profiles of Pola concentrations for the example STADS. 
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Figure 6 – Profiles of Pola concentrations for the example STDECAY. 
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3.6 SEASONCHAIN: First-Order Decay Chain of Nonlinearly Adsorbing 
Contaminants During Unsteady Flow8 
 
In this example we consider the transport of three (non)linearly adsorbing contaminants, Conta, 
Contb, and Contc that are involved in a sequential first-order decay chain defined as: 
 

 
where µw

'
,k are the first-order rate constants connecting two contaminants, µw,k is the first-order 

rate constant for Contc, Kd and nF are the Freundlich isotherm parameters for the three 
contaminants, and SoraConta, SorbContb, and SorcContc are the three surface species related to 
Conta, Contb, and Contc on three surfaces Sora, Sorb, and Sorc, respectively. Reaction 
parameters for the three contaminants are given in Table 1. Model simulations were carried out 
for a 1-m deep homogeneous soil profile during 1000 d, assuming transient flow. Upper 
boundary conditions were taken as daily precipitation rates representative for the Campine 
Region in Belgium. Evaporation was neglected during the simulations. The lower boundary 
condition was defined as free drainage. A uniform initial pressure head of –60 cm was assumed 
for the entire soil profile. For solute transport, the following initial and boundary conditions were 
considered: (1) initial concentrations equal to zero for all three contaminants, (2) third-type 
solute fluxes as the top boundary conditions with 1, 0.1, and 0 mol l-1 for Conta, Contb, and 
Contc, respectively, and (3) zero-gradient bottom boundary condition. Profile concentrations at 
selected times are shown in Figure 7. 

 

                                                 
8 Verification problem 5 in Jacques and Šimůnek (2005). 

 

' '
, , , , , ,

( , ) ( , ) ( , )d F d F d F

w k conta w k contb w k contc

K n K n K nconta contb contc

Conta Contb Contc

SoraConta SoraContb SoraContc

µ µ µ
⎯⎯⎯⎯⎯→ ⎯⎯⎯⎯⎯→ ⎯⎯⎯⎯⎯→

↓ ↓ ↓  (1) 

Table 1 Hydrological, transport, and reaction parameters for the example SEASONCHAIN. 

 Parameter Value Conta Contb ContC 
Hydraulic parameters θr (cm3cm-3) 

θs (cm3cm-3) 
α (cm-1) 
n (-) 
Ks (cm d-1) 

0.078 
0.43 
0.036 
1.56 
24.96 

   

Transport parameters DL (cm) 
ρ (g cm-3) 

1 
1.5 

   

Reaction parameters Kd (cm3 g-1) 
nF (-) 
µw' ,k (d-1) 
µw,k (d-1) 

 0.5 
1 
0.005 
- 

2.5 
0.9 
0.06 
- 

5 
0.8 
- 
0.02 

Kd is the Freundlich distribution coefficient, nF is the Freundlich exponent. µw,k and µ'w,k are 
the first-order decay coefficients (see Eq. (1) ). 
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3.7 CATEXCH: Transport of Heavy Metals Subject to Multiple Cation Exchange9 
 
In this problem, the transport of ten components (Al, Br, Ca, Cd, Cl, K, Mg, Na, Pb, and Zn) 
through a soil column is modeled. Initial and inflow concentrations of the ions are given in Table 
2. The cation exchange capacity is equal to 0.011 mol/1000 cm³. The soil core has a length of 8 
cm and is discretized into 40 cells of 0.2 cm. The flow velocity is 2 cm d-1 and the dispersivity is 
2 cm. Simulations were performed for 15 days. The maximum time step used in HP1 was 0.015 
d. Selected results are present in Figure 8 through Figure 11. 

                                                 
9 Verification problem 6 in Jacques and Šimůnek (2005). 

-100

-80

-60

-40

-20

0

0 0.2 0.4 0.6 0.8 1

D
is

ta
nc

e 
(c

m
)

Total concentration of Conta (mol/kg water)

      0 days 
250.00 days
500.00 days
1000.00 days
1095.00 days

-100

-80

-60

-40

-20

0

0 0.02 0.04 0.06 0.08 0.1

D
is

ta
nc

e 
(c

m
)

Total concentration of Contb (mol/kg water)

      0 days 
250.00 days
500.00 days
1000.00 days
1095.00 days

 

-100

-80

-60

-40

-20

0

0 0.02 0.04 0.06 0.08 0.1

D
is

ta
nc

e 
(c

m
)

Total concentration of Contc (mol/kg water)

      0 days 
250.00 days
500.00 days
1000.00 days
1095.00 days

 
Figure 7 – Profile plots of Conta, Contb and Contc concentrations at selected times for the example 
SEASONCHAIN. 
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Table 2 Initial and inflow concentrations for the example CATEXCH. 

mmol l-1 Initial pore water 
composition 

Initial concentrations of 
exchangeable cations* 

Inflow concentrations 

Al 
Ca 
Cd 
K 
Mg 
Na 
Pb 
Zn 
Br 
Cl 
pH  

0.5 
1 10-4 
0.09 
2 
0.75 
6 
0.1 
0.25 
11+ 
1 10-4 
5.5 

0.92 
2.88 10-4 
0.17 
1.06 
1.36 
0.62 
0.34 
0.76 
- 
- 
- 

0.1 
5 
0 
0 
1 
0 
0 
0 
3.7 
10 
2.9 

* Calculated in equilibrium with the initial pore water composition. 
+ Br is used to impose a charge balance at pH of 5.5. 
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Figure 8 – Time series of pH (top left), total concentrations of Ca (top right), Cd (bottom left), and 
Zn (bottom right) at four depths for the example CATEXCH. 
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Figure 9 – Time series of molalities of sorbed K (top left), Ca (top right), Cd (bottom left), and Zn 
(bottom right) at four depths for the example CATEXCH. 



 

 

26 

 

 

-8

-7

-6

-5

-4

-3

-2

-1

0

2.5 3 3.5 4 4.5 5 5.5

D
is

ta
nc

e 
(c

m
)

pH

      0 days 
  0.50 days
  1.00 days
  3.00 days
  9.00 days
 15.00 days

-8

-7

-6

-5

-4

-3

-2

-1

0

0 0.001 0.002 0.003 0.004 0.005

D
is

ta
nc

e 
(c

m
)

Total concentration of Ca (mol/kg water)

      0 days 
  0.50 days
  1.00 days
  3.00 days
  9.00 days
 15.00 days

 

-8

-7

-6

-5

-4

-3

-2

-1

0

0 0.0001 0.0002 0.0003

D
is

ta
nc

e 
(c

m
)

Total concentration of Cd (mol/kg water)

      0 days 
  0.50 days
  1.00 days
  3.00 days
  9.00 days
 15.00 days

-8

-7

-6

-5

-4

-3

-2

-1

0

0 0.00010.00020.00030.00040.00050.0006

D
is

ta
nc

e 
(c

m
)

Total concentration of Zn (mol/kg water)

      0 days 
  0.50 days
  1.00 days
  3.00 days
  9.00 days
 15.00 days

 
Figure 10 – Profiles of pH (top left), Ca (top right), Cd (bottom left), and Zn (bottom right) at 
selected times for the example CATEXCH. 
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3.8 MINDIS: Transport with Mineral Dissolution10 
 
A 100-cm long soil column, consisting of amorphous SiO2 and gibbsite (Al(OH)3), is leached 
with a solution containing 5.10-7 mol l-1 Si, 1.10-6 mol l-1 Al, and 1.10-3 mol l-1 Na (to obtain an 
inflow pH of 11.15). Initial concentrations are 1.76 10-3 mol l-1 Si, 8.87 10-9 mol l-1 Al, and 1 10-

12 mol l-1 Na, corresponding to a pH of 6.33. In each 1-cm thick cell, 0.015 mol amorphous SiO2 
and 0.005 mol gibbsite is present. The flow velocity is 2 cm/day and the dispersivity is 1 cm. 
Results are given in Figure 12. 
 

                                                 
10 Verification problem 7 in Jacques and Šimůnek (2005). 
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Figure 11 – Profiles of molalities of sorbed K (top left), Ca (top right), Cd (bottom left), and Zn 
(bottom right) at selected times for the example CATEXCH. 
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3.9 MCATEXCH: Transport of Heavy Metals in a Porous Medium with a pH-
Dependent Cation Exchange Complex 
 
This example considers the transport of several major cations (Na, K, Ca, and Mg) and three 
heavy metals (Cd, Zn, and Pb) through a 50-cm deep multi-layered soil profile during 
unsaturated steady-state flow. Each soil layer has different soil hydraulic properties and cation 
exchange capacities (CEC) (Table 4). The top 28 cm of the soil is assumed to be contaminated 
with three heavy metals (initial pH = 8.5), while an acid metal-free solution (pH = 3) infiltrates 
into the soil (Table 3). Assuming that the cation exchange complex is associated solely with the 
organic matter, CEC increases significantly with increasing pH due to the acid-base properties of 
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Figure 12 – Profiles of pH (top), total Si (middle left) and Al (middle right) concentrations, and 
amounts of amorf SiO2 (bottom left) and gibbsite (bottom right) at selected times for the example 
MINDIS. 
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its functional groups. The higher the pH, the more functional groups of the organic matter are 
deprotonated and thus the higher the cation exchange capacity. This behavior is represented by a 
multi-site cation exchange complex consisting of six sites, each having a different selectivity 
coefficient for the exchange of protons (see Appelo et al., 1998). Finally, chloride is present in 
the soil solutions, resulting in the formation of aqueous complexes with the heavy metals. 
 

 
 

The soil profile is assumed to contain five distinct layers with different soil hydraulic properties 
and cation exchange capacities. Table 4 gives thicknesses of the different horizons, parameters 
for the van Genuchten’s equations for the water retention and hydraulic conductivity functions 
(van Genuchten, 1980), and the total cation exchange capacities. The higher exchange capacities 
of the Bh1 and Bh2 horizons reflect their enrichment with the immobilized organic matter. Flow 
is assumed to be steady at a constant flux of 0.05 m day-1 (18.25 m year-1), which causes the soil 
profile to be unsaturated (water contents vary between 0.37 and 0.15 as a function of depth). The 

Table 3 pH and solution concentrations used in the simulation (µmol l-1). 

Solution pH Na* K Ca Mg Br Cl Cd Pb Zn 
0-28 cm depth 8.5 401.9 120 98 5 780 0 0.8 2.5 50 
28-50 cm depth 8.5 454.0 120 98 5 780 0 0.0 0 0 
Applied water 3.5 127.5 120 98 5 780 0 0.0 0 0 
* Concentration of Na is adjusted to obtain the desired pH. 

Table 4 Soil hydraulic properties and cation exchange capacities of five soil layers (Seuntjens, 2000). 

Horizon Layer 
thickness 
(cm) 

θr θs α 
(cm-1) 

n Ks
 

(cm day-1) 
l Cation exchange 

capacity 
(eq/1000 cm³ soil) 

A 
E 
Bh1 
Bh2 
Bh/C 

13 
10 
5 
5 
17 

0.065 
0.035 
0.042 
0.044 
0.039 

0.476 
0.416 
0.472 
0.455 
0.464 

0.016 
0.015 
0.016 
0.028 
0.023 

1.94 
3.21 
1.52 
2.01 
2.99 

93 
311 
39 
860 
1198 

0.5 
0.5 
0.5 
0.5 
0.5 

0.0183 
0.0114 
0.0664 
0.0542 
0.0116 

 

Table 5 Overview of aqueous equilibrium reactions and corresponding equilibrium constants (data from 
phreeqc.dat database, Parkhurst and Appelo, 1999). 

Nr Aqueous speciation reaction  Log_K  
(1) 
(2) 
(3) 
(4) 
(5) 

H2O = OH- + H+ 
Na+ + H2O = NaOH + H+ 
K+ + H2O = KOH + H+ 
Ca2+ + H2O = CaOH+ + H+ 
Mg2+ + H2O = MgOH+ + H+ 

 -14 
-14.18 
-14.46 
-12.78 
-11.44 

 

  Cd Pb Zn 
(6) 
(7) 
(8) 
(9) 
(10) 
(11) 
(12) 
(13) 

X2+ + H2O = XOH+ + H+ 
X2+ + 2 H2O = X(OH)2 + 2 H+ 
X2+ + 3 H2O = X(OH)3

- + 3 H+ 
X2+ + 4 H2O = X(OH)4

2- + 4 H+ 
X2+ + Cl- = XCl+ 
X2+ + 2 Cl- = XCl2 
X2+ + 3 Cl- = XCl3

- 
X2+ + 4 Cl- = XCl4

2- 

-10.08 
-20.35 
-33.30 
-47.35 
1.98 
2.60 
2.40 
- 

-7.71 
-17.12 
-28.06 
-39.70 
1.60 
1.80 
1.70 
1.38 

-8.96 
-16.90 
-28.40 
-41.20 
0.43 
0.45 
0.5 
0.2 
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bottom boundary condition for water flow is free drainage. HYDRUS-1D was used to calculate 
the steady-state water content profile corresponding to these boundary conditions. The 
dispersivity and diffusion coefficient were taken to be 0.05 m and 9.2 10-10 m2 s-1, respectively. 
 
An overview of the considered aqueous equilibrium reactions is given in Table 5. The role of 
chloride as a complexing agent is described by reactions (10) through (13). Other geochemical 
reactions that are considered are the heterogeneous multi-site ion-exchange reactions. The 
exchange coefficients for major cations and heavy metals were assumed to be the same for all 
exchange sites. Table 6 gives parameters for this multi-site exchange complex. 
 
Selected results are shown in Figure 13 and Figure 14. 
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Figure 13 – Outflow curves of pH (left) and Cd (right) for the example MCATEXCH. 

Table 6 Log K parameters for multi-site exchange complex. 

Y- NaY KY MgY2 CaY2 CdY2 PbY2 ZnY2 
exchanger(1) -1.0 -0.3 -0.4 -0.2 -0.2 0.05 -0.2 
HY(2) HYa HYb HYc HYd HYe HYf  
 1.65 3.3 4.95 6.85 9.6 12.35  
(1) The value for NaY is taken from Appelo et al. (1998). Values for the other complexes are taken from the 
phreeqc.dat database (Parkhurst and Appelo, 1999) and adapted relative to the K for NaY. 
(2) Values taken from Appelo et al. (1998). 
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Figure 14 – Profiles of pH (top left), Cd (top right), the fraction of deprotonated cation exchange 
sites (bottom left), and the fraction of cation exchange sites with Cd (bottom right) at selected times 
for the example MCATEXCH. 
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4 Step-By-Step Instructions for Selected Examples 
 
 

4.1 Dissolution of Gypsum and Calcite 
 

4.1.1 Problem Definition 
 
Sulfate-free water is infiltrated in a 50-cm long uniform soil column under steady-state saturated 
flow conditions. The reactive minerals present in the soil column are calcite (CaCO3) and 
gypsum (CaSO4.2H2O), both at a concentration of 2.176 x 10-2 mmol/kg soil.  
 
Physical properties of the soil column are as follows: the porosity of 0.35, the saturated hydraulic 
conductivity of 10 cm/day, the bulk density of 1.8 g/cm³, and the dispersivity of 1 cm. 
 
The input solution contains 1 mM CaCl2 and is in equilibrium with the atmospheric partial 
pressure of oxygen and carbon dioxide. The soil solution is in equilibrium with the reactive 
minerals and with the atmospheric partial pressure of oxygen. As a result of these equilibria, the 
initial soil solution contains only Ca and the oxidized components of S and C. 
 
Calculate the movement of the dissolution fronts of calcite and gypsum over a period of 2.5 
days. 
 

4.1.2 Input 
 
Project Manager 
 Button: "New" 
 Name: "HP1-1" 
 Description: "Dissolution of calcite and gypsum in the soil profile" 
 Button: "OK" 
 
Main Processes 
 Heading: Dissolution of calcite and gypsum in soil profile 
 Uncheck: "Water Flow" (Note: this is a steady-state water flow problem) 
 Check: "Solute Transport" 
 Select: "HP1 (PHREEQC)" 
 Button: “Next” 
 
Geometry Information 
 Depth of the Soil Profile: 50 (cm) 
 Button: “Next” 
 
Time Information 
 Final Time: 2.5 (days) 
 Maximum Time Step: 0.05 (days) 
 Button: “Next” 
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Print Information 
 Unselect: T-Level information 
 Select: Print at Regular Time Interval 
 Time Interval: 0.025 (days) 
 Print Times: Number of Print times: 5 
 Button: “Next” 
 
Print Times 
 Button: "Default" 
 Button: "OK" 
 
HP1 – Print and Punch Controls 
 Check: "Make GNUplot Templates" 

This allows easy visualization of time series and profile data for variables, which are 
defined in the SELECTED_OUTPUT section below in this dialog window and also 
defined in later in the editor Additional output of the Solute Transport – HP1 
Definitions dialog window. 

Button: “Next” 
 
Water Flow – Iteration Criteria 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Model 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Parameters 
 Qs: 0.35 
 Ks: 10 (cm/d) 
 Button: “Next” 
 
Water Flow – Boundary Conditions 
 Upper Boundary Condition: Constant Pressure Head 
 Lower Boundary Condition: Constant Pressure Head 
 
Solute Transport – General Information 
 Stability Criteria: 0.25 (to limit the time step) 
 Number of Solutes: 6 
 Button: “Next” 
 
Solute Transport – HP1 Components and Database Pathway 
 Six Components: Total_O, Total_H, Ca, C(4), Cl, S(6) 
 

Note: Redox sensitive components should be entered with the secondary master species, 
i.e., with their valence state between brackets. The primary master species of a redox 
sensitive component, i.e., the element name without a valence state, is not recognized as a 
component to be transported. Therefore, the primary master species C can not be entered 
here; one has to enter either C(4) or C(-4). Also, S is not allowed; one has to enter either 
S(6) or S(-2). Note that the HYDRUS GUI will not check if a correct master species is 
entered. Since the redox potential is high in this example (a high partial pressure of 
oxygen), the secondary master species C(-4) and S(-2) are not considered. 
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 Check: "Create PHREEQC.IN file using HYDRUS GUI" 
 Button: “Next” 
 
Solute Transport – HP1 Definitions 
 
 Definitions of Solution Compositions 
 

Define the initial condition, i.e., the solution composition of water in the soil 
column, with the solution number 1001:  

• Pure water 
• Bring it in equilibrium with gypsum, calcite, and O(0), to be in 

equilibrium with the partial pressure of oxygen in the atmosphere 
 
Define the boundary condition, i.e., the solution composition of water entering the 
soil column, with the solution number 3001:  

• Ca-Cl solution  
• Use pH to obtain the charge balance of the solution 
• Adapt the concentration of O(0) and C(4) to be in equilibrium with the 

atmospheric partial pressure of oxygen and carbon dioxide, respectively 
 

solution 1001 
 
equilibrium_phases 1001 
 gypsum 
 calcite 
 O2(g) -0.68 
save solution 1001 
end 

 
solution 3001 
 -units mmol/kgw 
 pH 7 charge 
 Cl 2 
 Ca 1 
 O(0) 1 O2(g) -0.68 
 C(4) 1 CO2(g) -3.5 

 
  Button: "OK" 
 
 Geochemical Model 
 

Define for each node the geochemical model. Note that the initial amount of a 
mineral must be defined as mol/1000 cm³ soil (i.e., 2.176 x 10-5 mol/kg soil * 1.8 
kg/1000 cm³ soil). 
 

Equilibrium_phases 1-101 
gypsum 0 3.9E-5 
calcite 0 3.9E-5 
O2(g) -0.68 

 
  Button: "OK" 
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 Additional Output 
 

Define the additional output to be written to selected output files.  
 
selected_output 
 -totals Ca Mg Cl S C 
 -equilibrium_phases gypsum calcite 

 
  Button: "OK" 
 

Button: “Next” 
 

Solute Transport – Solute Transport Parameters 
 Bulk D : 1.8 (g/cm³) 

Disp:  1 (cm) 
 Button: “Next” 
 
Solute Transport – Boundary conditions 
 Upper Boundary Condition  Bound. Cond. 3001 
 
Soil Profile – Graphical Editor 
 Menu: Conditions -> Initial Conditions -> Pressure Head 
 Button: "Edit Condition" 
   Select All 
   Top Value: 0 
 Menu: Conditions -> Observation Points 
 Button: "Insert" 
 Insert 5 observation nodes, one for every 10 cm 
 Menu: File -> Save Data 
 Menu: File –> Exit 
 
Soil Profile – Summary 
 Button: “Next” 
 
Run Application 
 
 

4.1.3 Output 
 
The standard HYDRUS-output can be viewed using commands in the right Post-processing part 
of the project window. Only the total concentrations of the components, which were defined in 
the Solute Transport – HP1 Components dialog window can be viewed using the GUI H1D. 
 
HP1 creates a number of additional output files in the project folder. The path to the project 
folder is displayed in the Project Manager: 
 
 File -> Project Manager 
 Directory: gives the path to the project group folder 

Input and output files of a given project are in the folder: directory\project_name 
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 where  directory is the project group folder 
  project_name is the project name 
 
Following HP1 output files are created for the HP1-1 project: 
 

Createdfiles.out An ASCII text file containing a list of all files created by HP1 (in 
addition to the output files created by the HYDRUS module of 
HP1); 

Phreeqc.out An ASCII text file, which is the standard output file created by the 
PHREEQC module in HP1; 

HP1-1.hse An ASCII text file, tab-delimited, that includes a selected output of 
all geochemical calculations in HP1 carried out before actual 
transport calculations. Inspection of this file can be done with any 
ASCII editor or spreadsheet, such as MS Excel; 

obs_nod_chem21.out 
obs_nod_chem41.out 
obs_nod_chem61.out 
obs_nod_chem81.out 
obs_nod_chem101.out A series of ASCII files, tab-delimited, with the selected output for 

the defined observation nodes (21, 41, 61, 81, and 101) at specific 
times (every 0.025 days). Numerical values can be seen by opening 
this file in any ASCII editor or a spreadsheet, such as MS Excel. A 
single plot of time series at five observation nodes can be generated 
for each geochemical variable with the ts_*.plt files using the 
GNUPLOT graphical program (see below); 

nod_inf_chem.out An ASCII file, tab-delimited, with the selected output for a 
complete soil profile at the defined observation times. Numerical 
values can be seen by opening this file in any ASCII editor or a 
spreadsheet, such as MS Excel. A single plot of the profile data at 
different observation times can be generated for each geochemical 
variable with the pd_*.plt files using GNUPLOT (see below); 

ts_pH.plt  
pd_pH.plt  
ts_pe.plt  
pd_pe.plt A series of ASCII files containing command line instructions to 

generate time series (ts_) or profile (pd_) plots of pH or pe using 
GNUPLOT; 

ts_tot_Ca.plt  
pd_tot_Ca.plt  
ts_tot_Cl.plt  
pd_tot_Cl.plt  
ts_tot_S.plt  
pd_tot_S.plt  
ts_tot_C.plt  
pd_tot_C.plt A series of ASCII files containing command line instructions to 

generate time series (ts_) or profile (pd_) plots with total 
concentrations of Ca, Cl, S, and C using GNUPLOT; note that this 
information can also be viewed through the H1D GUI; 

ts_eq_gypsum.plt  
pd_eq_gypsum.plt  
ts_eq_calcite.plt  
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pd_eq_calcite.plt  A series of ASCII files containing command line instructions to 
generate time series (ts_) or profile (pd_) plots with the amount of 
the minerals gypsum and calcite using GNUPLOT; 

ts_d_eq_gypsum.plt  
pd_d_eq_gypsum.plt  
ts_d_eq_calcite.plt  
pd_d_eq_calcite.plt  A series of ASCII files containing command line instructions to 

generate time series (ts_) or profile (pd_) plots with the change in 
the amount of the minerals gypsum and calcite using GNUPLOT; 

 
 

To view these various plots, the GNUPLOT code needs to be installed on your computer. 
GNUPLOT is freeware software that can be downloaded from http://www.gnuplot.info/. Note 
that GNUPLOT (the wgnuplot.exe program for the Windows OS) is usually, after being 
downloaded, in the gnuplot\bin folder and does not need any additional special installation. 
 
After opening the Window version of GNUPLOT by clicking on wgnuplot.exe, a plot can be 
directly generated by carrying out these commands: 
 
 File -> Open 
 Browse to project folder 
 Open the template file of interest (*.plt) 
 
The figure can be adapted using line commands (see tutorials for GNUPLOT on the internet). 
After adaptations, the command lines can be saved to be used later on.  
 
The default terminal for the plots is Windows. We illustrate here only how a plot can be 
transferred to another terminal: 
 
 Set terminal emf 
 Set output "name.emf" 
 Replot 
 Set terminal window 
 Replot 
 
A name.emf file is created in the project folder. 
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4.1.4 Overview of Selected Results: Profile Data 
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Figure 15 – Profiles of pH (top left), total aqueous C concentration (top right), total aqueous Ca 
concentration (middle left), total aqueous S concentration (middle right), the amount of gypsum 
(bottom left), and the amount of calcite (bottom right) at selected print times during dissolution of 
calcite and gypsum. 
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4.1.5 Overview of Selected Results: Time Series 
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Figure 16 – Time series of pH (top left), total aqueous C concentration (top right), total aqueous Ca 
concentration (middle left), total aqueous S concentration (middle right), the amount of gypsum 
(bottom left), and the amount of calcite (bottom right) at selected depths (observation nodes) during 
dissolution of calcite and gypsum. 
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4.2 Dissolution of Gypsum and Calcite and Transport of Cd 
 

4.2.1 Problem Definition 
 
Transport of a heavy metal through the soil column is investigated. Under high pH conditions, 
Cd precipitates as otavite (CdCO3). However, due to changing geochemical conditions in the soil 
column, solubility of Cd is changing. This example studies Cd mobility through the soil column.  
 
The physical and geochemical set up, as in paragraph 4.1.1, is used as the basis. The infiltrating 
water is contaminated with a small amount of Cd (1 x 10-6 M Cd). Otavite is added to the 
geochemical model with a small initial amount (1 x 10-10 mol/1000 cm³ of soil). 
 
Calculate the percentage of Cd in the aqueous phase. The basic statement SYS("Cd") gives the 
total moles of Cd in the system, whereas the statement TOT("Cd") gives the total concentration 
of Cd in the aqueous phase. The total amount of water (in kg) is obtained using the BASIC 
statement TOT("water"). 
 

4.2.2 Input 
 
Project Manager 
 Select project: "HP1-1" 
 Button: "Copy" 
 New Name: "HP1-2" 
 Description: "Mineral dissolution/precipitation: Cd transport" 
 Button: "OK" 
 
Main Processes 
 Heading: Mineral dissolution/precipitation: Cd transport 
 Button: "OK" 
 
Solute Transport – General Information 
 Number of Solutes: 7 
 Button: “Next” 
 
Solute Transport – HP1 Components and Database Pathway 
 Add Cd 
 Button: “Next” 
 
Solute Transport – HP1 Definitions 
 
 Definitions of Solution Compositions 
 

 Add the concentration of Cd into the boundary solution (solution 3001) 
 

solution 3001 
 pH 7 charge 
 Cl 2 
 Ca 1 
 O(0) 1 O2(g) -0.68 
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 C(4) 1 CO2(g) -3.5 
 Cd 1E-3 

 
  Button: "OK" 
 
 Geochemical Model 
 

Add the mineral otavite to the EQUILIBRIUM_PHASES assemblage and define its 
initial amount 

 
equilibrium_phases 1-101 
 gypsum 0 3.9E-5 
 calcite 0 3.9E-5 
 Otavite 0 1E-10 
 O2(g) -0.68 

 
  Button: "OK" 
 
 Additional Output 
 

Add Cd to the list of –totals 
Add otavite to the list of –equilibrium_phases 
Add a USER_PUNCH to calculate the percentage of Cd in solution:  

 
selected_output 
 -totals Ca Cl S C Cd 
 -equilibrium_phases gypsum calcite otavite 
 
user_punch 
 -headings Percentage_Cd_in_solution@- 
 -start 
  10 if (Sys("Cd") > 0) then perCd = 100 * tot("Cd") 
* tot("water") / sys("Cd") else perCd = 0 
  20 punch perCd  
 -end 

 
Note on headings: A specific format of the headings can be used to have an 
appropriate labeling of the axes in the GNUPLOT templates. The underscore _ 
is interpreted as a white space; the symbol @ separates the name of a variable 
from its unit. Thus, for the headings defined above, the corresponding axis text 
in the GNUPLOT template is "Percentage Cd in solution (-)". 

 
  Button: "OK" 
 

Button: "OK" 
 

Run Application 
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4.2.3 Output 
 
Profiles of Cd, otavite and percentage of Cd in the solution are shown in Figure 17. The plot of 
the percentage of Cd in the solution is generated by opening the file 'pd_user_Percentage Cd in 
solution.plt' using GNUPLOT (USER_PUNCH variables are indicated by *_user_*.plt). 
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Figure 17 – Profiles of total aqueous Cd (top left), the amount of otavite (top right), and the 
percentage of Cd in solution (bottom) at selected print times during dissolution of calcite and 
gypsum and Cd transport. 
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4.3 Dissolution of gypsum and calcite and transport of Cd – the effect of higher Cl 
concentrations on the Cd mobility 
 

4.3.1 Problem Definition 
 
Aqueous components, which form strong complexes with Cd, will enhance the mobility of Cd. 
The same physical and geochemical set up as in the previous example (paragraph 4.2) is used 
here, but the composition of the inflowing water is changed after 1 day to a solution with a 
higher CaCl2 concentration (1 x10-2 M).  
 

4.3.2 Input 
 
Project Manager 
 Select project: "HP1-2" 
 Button: "Copy" 
 New Name: "HP1-3" 
 Description: "Mineral dissolution/precipitation: Cd transport and effect of Cl" 
 Button: "OK" 
 
Main Processes 
 Heading: Mineral dissolution/precipitation: Cd transport and effect of Cl 
 Button: "OK" 
 
Time Information 
 Check: "Time-Variable Boundary Conditions" 
 Number of Time-Variable Boundary Conditions: 2 
 Button: "OK" 
 
Solute Transport – HP1 Definitions 
  
 Definitions of Solution Compositions 
 
  Add solution 3002: The boundary solution with the higher CaCl2 concentration 
  Add solution 4001: The bottom boundary solution – pure water 
 

solution 3002 
 pH 7 charge 
 Cl 20 
 Ca 10 
 O(0) 1 O2(g) -0.68 
 C(4) 1 CO2(g) -3.5 
 Cd 1E-3 
 
solution 4001 

 
  Button: "OK" 
 Button: "OK" 
 
Time Variable Boundary Conditions 
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 Time: 1, 2.5 (in column) 
 cTop: 3001, 3002 
 cBot: 4001, 4001 
 Button: "OK" 
 
Run Application 
 

4.3.3 Output 
 
Figure 18 compares the time series of Cd concentrations and the profile of the amount of otavite 
between the project described in paragraph 4.2 and the current project.  
 
At the first observation depth, breakthrough curves of Cd are quite similar. The calcite and 
otavite dissolution fronts already reached this depths after 1 day (see Figure 17), and the high Cl 
concentration entering the system after 1 day has only a small effect on these dissolution fronts. 
 
However, deeper in the soil, an increase in Cd concentration occurs already after 1.5 days at 20 
cm depth in the case when high Cl concentrations enter the system after 1 day. Note that in the 
case of a constant low Cl concentration, the Cd peak does not pass the depth of 20 cm until after 
2.5 days. In the case when a high Cl concentration enters the system after 1 day, the otavite 
dissolution front does not follow the calcite dissolution front, as was observed in the case when a 
constant low Cl concentration enters the system. Otavite dissolution follows the Cl concentration  
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Figure 18 – Comparison between a simulation when a solution with a low Cl concentration enters the 
system (described in paragraph 4.2, left figures) and a simulation when a solution with a high Cl 
concentration enters the system after 1 day (described in paragraph 4.3, right figures) for time series 
of Cd concentrations at different depths (top figures) and profiles of the amount of otavite (bottom 
figures). 
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infiltration front (see Figure 18). Due to the high Cl concentrations, solubility of Cd is increased 
and otavite is not formed anymore after 1.5 days.  
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Figure 19 – Time series of Cl at selected depths (observation nodes) for the example described in 
section 4.3. 
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4.4 Transport and Cation Exchange (Single Pulse) 

4.4.1 Problem Definition 
 
This example is adapted from Example 11 of the PHREEQC manual (Parkhurst and Appelo, 
1999). We will simulate the chemical composition of the effluent from an 8-cm column 
containing a cation exchanger. The column initially contains a Na-K-NO3 solution in equilibrium 
with the cation exchanger. The column is flushed with three pore volumes of a CaCl2 solution. 
Ca, K, and Na are at all times in equilibrium with the exchanger. The simulation is run for one 
day; the fluid flux density is equal to 24 cm/d (0.00027777 cm/s).   

The column is discretized into 40 finite elements (i.e., 41 nodes). The example assumes that the 
same solution is initially associated with each node. Also, we use the same exchanger 
composition for all nodes. 

The initial Na-K-NO3 solution is made by using 1 x 10-3 M NaNO3 and 2 x 10-4 KNO3 M. The 
inflowing CaCl2 solution has a concentration of 6 x 10-4 M. Both solutions were prepared under 
oxidizing conditions (in equilibrium with the atmospheric partial pressure of oxygen). The 
amount of exchange sites (X) is 1.1 meq / 1000 cm³ soil. The log K constants for the exchange 
reactions are defined in the PHREEQC.dat database and do not have to be therefore specified at 
the input. 

In this example, only the outflow concentrations of Cl, Ca, Na, and K are of interest. 

4.4.2 Input 
 
Project Manager 

Button "New" 
Name: CEC-1 
Description: Transport and Cation Exchange, single pulse 
Button "OK" 
 

Main Processes 
Heading: Transport and Cation Exchange, single pulse 
Uncheck "Water Flow" (steady-state water flow) 
Check "Solute Transport"  
Select “HP1 (PHREEQC)” 
Button “Next” 
 

Geometry Information 
Depth of the soil profile: 8 (cm) 
Button “Next” 

 
Time Information 

Time Units:  Seconds (Note that you can also just put it in days, this would also 
be OK) 

Final Time:   86400 (s) 
Initial Time Step:  180 (s) 
Minimum Time Step: 180 (s) 
Maximum Time Step:  180 (s) (Note: constant time step to have the same conditions as 

in the original comparable PHREEQC calculations) 
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Button “Next” 
 

Print Information 
Number of Print Times: 12 
Button "Select Print Times" 
Button “Next” 

Print Times 
Button: “Default” 
Button: “OK” 
 

HP1 – Print and Punch Controls 
Button: "Next 
 

Water Flow - Iteration Criteria 
Lower Time Step Multiplication Factor: 1 
Button “Next” 

 
Water Flow - Soil Hydraulic Model 

Button “Next” 
 
Water Flow - Soil Hydraulic Parameters 

Catalog of Soil Hydraulic Properties: Loam 
Qs:  1 (Note: to have the same conditions as in the original comparable PHREEQC 

calculations) 
Ks: 0.00027777 (cm/s) 
Button “Next” 

 
Water Flow - Boundary Conditions 

Upper Boundary Condition: Constant Pressure Head 
Lower Boundary Condition: Constant Pressure Head 
Button “Next” 

 
Solute Transport - General Information 

Number of Solutes: 7 
Button “Next” 

 
Solute Transport – HP1 Components and Database Pathway 
 Add seven components:  Total_O, Total_H, Na, K, Ca, Cl, N(5) 
 Check: "Create PHREEQC.IN file using HYDRUS GUI" 
 Button: “Next” 
 
Solute Transport – HP1 Definitions 
 
 Definitions of Solution Compositions 
 

Define the initial condition 1001:  
• K-Na-N(5) solution 
• Use pH to obtain the charge balance of the solution 
• Adapt the concentration of O(0) to be in equilibrium with the atmospheric 

partial pressure of oxygen  
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Define the boundary condition 3001:  

• Ca-Cl solution  
• Use pH to obtain the charge balance of the solution 
• Adapt the concentration of O(0) to be in equilibrium with the atmospheric 

partial pressure of oxygen  
 

Solution 1001 Initial condition 
 -units mmol/kgw 
 pH 7 charge 
 Na 1 
 K 0.2 
 N(5) 1.2 
 O(0) 1 O2(g) -0.68 
 
Solution 3001 Boundary solution 
 -units mmol/kgw 
 pH 7 charge 
 Ca 0.6 
 Cl 1.2 
 O(0) 1 O2(g) -0.68 

 
 Geochemical Model 
 

Define for each node (41 nodes) the geochemical model, i.e., the cation exchange 
assemblage X (0.0011 moles/1000 cm³) and equilibrate it with the initial solution 
(solution 1001). 
 

EXCHANGE 1-41 @Layer 1@ 
 X 0.0011 
 -equilibrate with solution 1001 

 
Button: "OK" 
 
 

Additional Output 
 

Since output is required only for the total concentrations and such output is 
available in the automatically generated file obs_node.out, there is no need to 
define additional output. 

 
Button: “Next” 

 
Solute Transport - Transport Parameters 

Bulk Density: 1.5 (g/cm³) 
Disp.:   0.2 (cm) 
Button “Next” 

 
Solute Transport - Boundary Conditions 

Upper Boundary Condition:  Concentration Flux 
Add the solution composition number (i.e., 3001) for the upper boundary condition 
Lower Boundary Condition:  Zero Gradient 
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Button “Next” 
 
Soil Profile - Graphical Editor 

Menu: Conditions->Profile Discretization 
or Toolbar: Ladder 

  Number (from sidebar): 41 
Menu: Conditions->Initial Conditions->Pressure Head 
or Toolbar: red arrow 
Button "Edit condition", select with Mouse the entire profile and specify 0 cm pressure 
head. 
Menu: Conditions->Observation Points 
Button "Insert", Insert a node at the bottom 
Menu: File->Save Data 
Menu: File->Exit 

 
Soil Profile - Summary 

Button “Next” 
 
Close Project 
 
Run project 

Note: This exercise will produce the following warnings: "Master species N(3) is present in 
solution n but is not transported.". The same warning occurs for N(0). N(3) and N(0) are two 
secondary master species from the primary master species N. Only the secondary master species 
N(5) was defined as a component to be transported (the Solute Transport – HP1 Components 
dialog window). HP1, however, checks if all components, which are present during the 
geochemical calculations, are defined in the transport model. If not, a warning message is 
generated. In our example, the concentrations of the components N(0) and N(3) are very low 
under the prevailing oxidizing conditions. Therefore, they can be neglected in the transport 
problem. If you want to avoid these warnings, you have to either include N(0) and N(3) as 
components to be transported or define an alternative primary master species representing nitrate 
(such as Nit-) using SOLUTION_MASTER_SPECIES and SOLUTION_SPECIES.   
 

4.4.3 Output 
 
Display results for “Observation Points” or “Profile Information”. Alternatively, Figure 20 can 
be created using information in the output file obs_nod.out. 
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The results for this example are shown in Figure 20. The concentrations for node 41 (the last 
node) are plotted against time. Chloride is a conservative solute and arrives in the effluent at 
about one pore volume. The sodium initially present in the column exchanges with the incoming 
calcium and is eluted as long as the exchanger contains sodium. The midpoint of the 
breakthrough curve for sodium occurs at about 1.5 pore volumes. Because potassium exchanges 
more strongly than sodium (larger log K in the exchange reaction; note that log K for individual 
pairs of cations are defined in the database and therefore did not have to be specified), potassium 
is released after sodium. Finally, when all of the potassium has been released, the concentration 
of calcium increases to a steady-state value equal to the concentration of the applied solution. 
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Figure 20 – Outflow concentrations of Cl, Ca, Na, and K for the single-pulse 
cation exchange example. 
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4.5 Transport and Cation Exchange (Multiple Pulses) 
 

4.5.1 Problem Definition 
 
This example is the same as the one described in paragraph 4.5, except that time variable 
concentrations are applied at the soil surface. 

The following sequence of pulses is applied at the top boundary: 

0 –  8 hr: 6 x 10-4 M CaCl2 

8 – 18 hr: 5 x 10-6 M CaCl2, 1 x 10-3 M NaNO3, and 2 x 10-4 M KNO3 

18 – 38 hr: 6 x 10-4 M CaCl2 

38 – 60 hr: 5 x 10-6 M CaCl2, 1 x 10-3 M NaNO3, and 8 x 10-4 M KNO3 

 

4.5.2 Input 
 
Project Manager 

Click on CEC-1 
Button "Copy" 
New Name: CEC-2 
Description: Transport and Cation Exchange, multiple pulses 
Button "OK", "Open" 
 

Main Processes 
Heading: Transport and Cation Exchange, multiple pulses 
Button: “Next” 
 

Geometry Information 
Button: “Next” 
 

Time Information 
Time Units:   hours 
Final Time:   60 (hr) 
Initial Time Step:  0.1 (hr) 
Minimum Time Step: 0.05 (hr) 
Maximum Time Step: 0.1 (hr) 
Number of Time-Variable Boundary Records: 4 
Button “Next” 
 

Print Information 
Number of Print Times: 12 
Button "Select Print Times" 
Default 
Button “Next” 
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Solute Transport - General Information 
Button “Next” 

 
Solute Transport – HP1 Components and Database Pathway 
   Button: “Next” 
 
Solute Transport – HP1 Definitions 
 
 Definitions of Solution Compositions 
 

Add additional boundary solution compositions with numbers 3002 and 3003. 
Define a bottom boundary solution: Solution 4001 – pure water 
 

Solution 3002 Boundary solution 
 -units mmol/kgw 
 ph 7 charge 
 Na 1 
 K 0.2 
 N(5) 1.2 
 Ca 5E-3 
 Cl 1E-2 
 O(0) 1 O2(g) -0.68 
 
Solution 3003 Boundary solution 
 -units mmol/kgw 
 ph 7 charge 
 Na 1 
 K 0.8 
 N(5) 1.8 
 Ca 5E-3 
 Cl 1E-2 
 O(0) 1 O2(g) -0.68 
 
solution 4001 bottom boundary solution 
 #pure water 

 
Button: "OK" 

Button: “Next” 
 

Solute Transport - Boundary Conditions 
Upper Boundary Condition:  Concentration Flux 
Lower Boundary Condition:  Zero Gradient 
Button “Next” 

 
Time-Variable Boundary Conditions 

Fill in the time, and the solution composition number for the top boundary 
 
Time cTop cBot 
8 3001 4001 
18 3002 4001 
38 3001 4001 
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60 3003 4001  
 
Soil Profile - Graphical Editor 

Menu: Conditions->Observation Points 
Button "Insert", Insert nodes at 2, 4, 6, and 8 cm 
Menu: File->Save Data 
Menu: File->Exit 

 
Soil Profile - Summary 

Button “Next” 
 
Run Project 
 

4.5.3 Output 
 
Figure 21 gives the K concentration at different depths in the profile. Figure 22 shows the 
outflow concentration. The first pulse is identical to the single pulse project. Then additional 
solute pulses of different solution compositions will restart the cation exchange process 
depending on the incoming solution composition. 
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Figure 21 – Time series of K concentrations at four depths for the multiple-
pulse cation exchange example. 
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4.6 Transport of Cations and Heavy Metals in a Multi-Layered Soil 
 

4.6.1 Background 
 
Cation adsorption onto negatively charged solid surfaces can greatly affect the rate of the heavy 
metal transport in soils. The degree of adsorption of a particular cation depends on its 
concentration, the concentration of other cations in the soil solution, and the adsorbed 
concentration of the major cations and heavy metals. The competition between major cations and 
heavy metals for adsorption sites can be described using a multicomponent equilibrium ion 
exchange approach (e.g., Selim and Amacher, 1997, and references therein). In addition to major 
cations and heavy metals, protons also adsorb to the solid surfaces. Due to the acid-base 
properties of the functional groups on the surfaces of minerals and organic matter, the percentage 
of H+ adsorption decreases significantly with increasing pH. This leads to an increased capacity 
of the surfaces to adsorb major cations and heavy metals at higher pH values. This behavior can 
also be described by means of a multi-site cation exchange complex consisting of several sites, 
each having a different selectivity coefficient for the exchange of protons (see also paragraph 
3.9). Appelo et al. (1998), for example, used six sites to describe cation exchange in the presence 
of organic matter and Fe-oxyhydroxides. 
 

4.6.2  Problem Definition 
 
This example simulates the migration of major cations and heavy metals in a multi-layered 1-m 
deep soil profile using the multi-site cation exchange model.  
 
Soil hydraulic and physical parameters ( 
) of the dry Spodosol located at the “Kattenbos” site near Lommel, Belgium, were taken from 
Seuntjens (2000, Tables 3.1 and 7.1). The cation exchange complex was assumed to be 
associated solely with organic matter. The cation exchange capacity hence is directly related to 
the amount of exchangeable protons on the organic matter, taken to be 6 meq/g of the organic 
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Figure 22 – Outflow concentrations for the multiple-pulse cation exchange 
example. 
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matter (proton dissociating groups on fulvic acids are 6 – 10 meq/g and 4 – 6 meq/g on humic 
acids, Tipping, 2002).  
 
Table 7 Soil hydraulic and other properties of six soil horizons (from Seuntjens, 2000). 
 

  
Steady-state water flow of 1 cm day-1 is assumed in this example. The composition of the 
inflowing water changes as a function of time: 
 

• 0 – 27.9 days: Ca: 0.005 mol l-1, Cl: 0.01 mol l-1 
• 27.9 – 28.9 days: Ca: 0.05 mol l-1, Cl: 0.1 mol l-1 
• 28.9 – 80 days: Ca: 0.005 mol l-1, Cl: 0.01 mol l-1 
 

These upper boundary conditions correspond with experimental conditions in a lysimeter 
experiment described in Seuntjens (2000). At the bottom of the lysimeter, capillary wicks with a 
length of 38 cm were installed. Taking into account the hydraulic properties of the wick and the 
steady-state water flow of 1 cm/d, the lower boundary pressure head is –28.3 cm. For the initial 
distribution of the pressure heads, it is assumed that the pressure head throughout the soil profile 
is initially in gravitational equilibrium with the lower boundary condition, (i.e. -28.3 at the 
bottom and -128.3 cm at the top, and linearly increasing with depth between). 
 

The transport of 10 components is considered: Na, K, Ca, Mg, Cd, Zn, Pb, Cl, Br and C(4). In 
addition, Total_O and Total_H are included. Initial concentrations for the first nine components 
are given in Table 8. Br- is used as a charge balance ion to have the desired initial pH, also 
defined in Table 8. O(0) and C(4) are considered in equilibrium with the atmospheric partial 
pressure of oxygen and carbon dioxide. Initial concentrations of Ca2+, Cd2+, and Zn2+ were 

Horizon Depth 
(cm) 

ρ 
(g cm³) 

Organic 
Carbon 
% 

θr 
 

θs 
 

α 
(cm-1) 

n Ks 
(cm 
day-1) 

A 
E 
Bh1 
Bh2 
BC 
C1 
C2 

0 – 7 
7 – 19 
19 – 24 
24 – 28 
28 – 50 
50 – 75 
75 – 100 

1.31 
1.59 
1.3 
1.38 
1.41 
1.52 
1.56 

2.75 
0.75 
4.92 
3.77 
0.89 
0.12 
0.08 

0.065 
0.035 
0.042 
0.044 
0.039 
0.030 
0.021 

0.48 
0.42 
0.47 
0.46 
0.46 
0.42 
0.39 

0.016 
0.015 
0.016 
0.028 
0.023 
0.021 
0.021 

1.94 
3.21 
1.52 
2.01 
2.99 
2.99 
2.99 

95.04 
311.04 
38.88 
864 
1209.6 
1209.6 
1209.6 

Table 8 Initial pH and concentration for 9 components.  
 

Concentration 
(µmol/l) 

pH Cl Na K Ca Mg Cd Zn Pb 

A 
E 
Bh1 
Bh2 
BC 
C1 
C2 

3.4 
3.5 
3.6 
3.8 
4.4 
4.4 
4.5 

69 
69 
69 
69 
69 
69 
69 

64 
64 
64 
64 
64 
64 
64 

4 
4 
4 
4 
4 
4 
4 

97 
65 
39 
33 
55 
76 
27 

8 
8 
8 
8 
8 
8 
8 

0.80 
0.38 
0.43 
0.41 
0.63 
0.33 
0.20 

50 
24 
23 
21 
33 
21 
14 

2.5 
1.2 
1.1 
1.0 
1.6 
1.0 
0.7 
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obtained from Seuntjens (2000; Table 7.1). Pb2+ concentrations were arbitrarily set to be 20 
times smaller than the Zn2+ concentrations (no data available). 
 

4.6.3 Cation Exchange Capacities 
 
Assuming an average exchange capacity of 6 meq/g of organic matter, the exchange capacity is 
obtained as: ρb(gram soil/cm³) x OC (% or gram organic matter/100 g soil) × 6 meq/gram of 
organic matter. For example, for the A horizon, this results in 0.216 meq/cm3 of soil. This value 
must then be transformed to units of moles/1000 of cm³ soil (i.e., 0.216 moles/1000 cm3 of soil). 
 

4.6.4 Input 
 
Project Manager 
 Button: "New" 
 Name: "CatExch" 
 Description: "Cation exchange in a multilayered soil" 
 Button: "OK" 
 
Main Processes 
 Heading: Cation exchange in a multilayered soil 
 Check: "Water Flow" 
 Check: "Solute Transport" 
 Select: "HP1 (PHREEQC)" 
 Button: “Next” 
 
Geometry Information 
 Lenghts Units: cm 
 Number of Soil Materials: 7  
 Depth of the Soil Profile: 100 (cm) 
 Button: “Next” 
 
Time Information 
 Final Time: 80 (days) 
 Initial Time Step: 0.001 (days) 
 Minimum Time Step: 1E-5 (days) 
 Maximum Time Step: 0.5 (days) 
 Check: "Time Variable Boundary Conditions" 
 Number of Time-Variable Boundary Records: 3 
 Button: “Next” 
 
Print Information 
 Unselect: T-Level information 
 Select: Print at Regular Time Interval 
 Time Interval: 0.5 (days) 
 Print Times: Number of Print times: 4 
 Button: “Next” 
 
Print Times 
 Button: "Default" 
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 Button: "OK" 
 
HP1 – Print and Punch Controls 
 Check: "Make GNUplot Templates" 

Button: “Next” 
 
Water Flow – Iteration Criteria 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Model 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Parameters 
 Insert the hydraulic properties from Table 7.  

 
 
 Button: “Next” 
 
Water Flow – Boundary Conditions 
 Upper Boundary Condition: Constant Flux 
 Lower Boundary Condition: Constant Pressure Head 
 
Water Flow – Constant Boundary Fluxes 
 Upper Boundary Flux: -1 (cm/day) (downward flux) 
 
Solute Transport – General Information 
 Stability Criteria: 0.25 
 Number of Solutes: 12 
 Button: “Next” 
 
Solute Transport – HP1 Components and Database Pathway 
 Twelve Components: Total_O, Total_H, Na, K, Ca, Mg, Cd, Zn, Pb, Cl, Br, C(4) 
 Check: "Create PHREEQC.IN file using HYDRUS GUI" 
 Button: “Next” 
 
Solute Transport – HP1 Definitions 
 
 Definitions of Solution Compositions 
 

Define the initial solutions for each of the seven layers (Table 8), and use solution 
numbers 1001-1007 and the keyword SOLUTION_SPREAD: 
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• Use pH to obtain charge balance of the solution 
• Adapt the concentration of O(0) and C(4) to be in equilibrium with the 

atmospheric partial pressure of oxygen and carbon dioxide, respectively. 
 

Note: columns of SOLUTION_SPREAD, as well as the headings and the 
subheadings must be tab-delimited (see PHREEQC-2 manual, Parkhurst and 
Appelo, 1999). A convenient way to prepare the input for the 
SOLUTION_SPREAD keyword is to use MS Excel to make different input rows 
and columns and to copy it to the H1D GUI: 
 

 
 
Define the boundary condition 3001:  

• Ca-Cl solution: low concentration 
• Use pH to obtain the charge balance of the solution 
• Adapt the concentration of O(0) to be in equilibrium with the atmospheric 

partial pressure of oxygen  
 
Define the boundary condition 3002:  

• Ca-Cl solution: high concentration 
• Use pH to obtain the charge balance of the solution 
• Adapt the concentration of O(0) to be in equilibrium with the atmospheric 

partial pressure of oxygen  
 
Define the boundary condition 4001:  

• Pure water 
 
 

 



 

 

59

   

S
O
L
U
T
I
O
N
_
S
P
R
E
A
D
 

 
N
u
m
b
e
r
 
 
D
e
s
c
r
i
p
t
i
o
n
 

 
 
p
H
 

 
 
 
 
C
l
 

 
 
 
 
N
a
 

 
 
 
 
K
 

 
 
 
 
 
 
C
a
  
 
 
 
 
 
M
g
  
 
 
 
 
 
C
d
  
 
 
 
 
 
Z
n
  
 
 
 
 
 
P
b
  
 
 
 
 
B
r
 
 
 
 
 
 
 
 
 
O
(
0
)
 

 
 
 
 
 
 
 
 
C
(
4
)
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
  
c
h
a
r
g
e
 
 
O
2
(
g
)
 
-
0
.
6
8
 

 
C
O
2
(
g
)
 
-
3
.
5
 

 
 
 
1
0
0
1
 
 
 
 
h
o
r
i
z
o
n
a
 
A
 

 
3
.
4
 

 
6
9
E
-
3
 

 
6
4
E
-
3
 

 
4
E
-
3
 

 
9
.
7
E
-
0
2
  
8
.
0
E
-
0
3
  
8
.
0
E
-
0
4
  
5
.
0
E
-
0
2
  
2
.
5
E
-
0
3
  
 
 
1
E
-
3
 
 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
1
0
0
2
 
 
 
 
h
o
r
i
z
o
n
 
E
 

 
3
.
5
 

 
6
9
E
-
3
 

 
6
4
E
-
3
 

 
4
E
-
3
 

 
6
.
5
E
-
0
2
  
8
.
0
E
-
0
3
  
3
.
8
E
-
0
4
  
2
.
4
E
-
0
2
  
2
.
4
E
-
0
2
  
 
 
1
E
-
3
 
 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
1
0
0
3
 
 
h
o
r
i
z
o
n
 
B
h
1
 

 
3
.
6
 

 
6
9
E
-
3
 

 
6
4
E
-
3
 

 
4
E
-
3
 

 
3
.
9
E
-
0
2
  
8
.
0
E
-
0
3
  
4
.
3
E
-
0
4
  
2
.
3
E
-
0
2
  
2
.
3
E
-
0
2
  
 
 
1
E
-
3
 
 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
1
0
0
4
 
 
h
o
r
i
z
o
n
 
B
h
2
 

 
3
.
8
 

 
6
9
E
-
3
 

 
6
4
E
-
3
 

 
4
E
-
3
 

 
3
.
3
E
-
0
2
  
8
.
0
E
-
0
3
  
4
.
1
E
-
0
4
  
2
.
1
E
-
0
2
  
2
.
1
E
-
0
2
  
 
 
1
E
-
3
 
 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
1
0
0
5
 
 
 
h
o
r
i
z
o
n
 
B
C
 

 
4
.
4
 

 
6
9
E
-
3
 

 
6
4
E
-
3
 

 
4
E
-
3
 

 
5
.
5
E
-
0
2
  
8
.
0
E
-
0
3
  
6
.
3
E
-
0
4
  
3
.
3
E
-
0
2
  
3
.
3
E
-
0
2
  
 
 
1
E
-
3
 
 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
1
0
0
6
 
 
 
h
o
r
i
z
o
n
 
C
1
 

 
4
.
4
 

 
6
9
E
-
3
 

 
6
4
E
-
3
 

 
4
E
-
3
 

 
7
.
6
E
-
0
2
  
8
.
0
E
-
0
3
  
3
.
3
E
-
0
4
  
2
.
1
E
-
0
2
  
2
.
1
E
-
0
2
  
 
 
1
E
-
3
 
 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
1
0
0
7
 
 
 
h
o
r
i
z
o
n
 
C
2
 

 
4
.
5
 

 
6
9
E
-
3
 

 
6
4
E
-
3
 

 
4
E
-
3
 

 
2
.
7
E
-
0
2
  
8
.
0
E
-
0
3
  
2
.
0
E
-
0
4
  
1
.
4
E
-
0
2
  
1
.
4
E
-
0
2
  
 
 
1
E
-
3
 
 
 
 
 
 
 
 
 
1
E
-
3
 

 
 
 
 
 
 
 
 
1
E
-
3
 

  



 

 

60 

solution 3001 
  pH 7 charge 
  units mol/kgw 
  Ca 0.005   
  Cl 0.01 
  O(0) 1 O2(g) -0.68 
 
solution 3002 
 pH 7 charge 
 units mol/kgw 
 Ca 0.05 
 Cl 0.1 
 O(0) 1 O2(g) -0.68 
 
solution 4001 #pure water 

 
 

  Button: "OK" 
 
 Geochemical Model 
 

The geochemical model will be defined after different layers of the soil profile have 
been defined using Soil Profile – Graphical Editor. Information about the 
distribution of different layers can then be used in the definition of the geochemical 
model (see below). 

 
 Additional Output 
 

Define the additional output to be written to selected output files.  
 

selected_output 
 -totals Cd Ca Cl 
 
user_punch 
 -headings Adsorbed_Cd@mol/kg_soil 
 -start 
  10 bd = bulkdensity(cell_no)  
  40 PUNCH mol("CdX2")*tot("water")/bd 
 -end 

 
  Button: "OK" 
 

Button: “Next” 
 

Solute Transport – Solute Transport Parameters 
Add the bulk density for the seven layers ( 
): 1.31, 1.59, 1.3, 1.38, 1.41, 1.52, 1.56 (g/cm³) 
Disp:  1 (cm) 

 Button: “Next” 
 
Solute Transport – Boundary conditions 
 Upper Boundary Condition: Concentration Flux BC 
 Lower Boundary Condition: Zero Concentration Gradient 
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Time Variable Boundary Conditions 
 
 Time (days) cTop cBot 
 27.9 3001 4001 
 28.9 3002 4001 
 80 3001 4001 
 
Soil Profile – Graphical Editor 
 Button: "Edit Condition" 
 Select: with the mouse  
   nodes 8 to 19: specify Material 2 
   nodes 20 to 24: specify Material 3 
   nodes 25 to 28: specify Material 4 
   nodes 29 to 50: specify Material 5 
   nodes 51 to 75: specify Material 6 
   nodes 76 to 100: specify Material 7 
 Menu: Conditions -> Initial Conditions -> Pressure Head 
 Button: "Edit Condition" 
   Select All 
   Top Value:  -128.3 
   Bottom Value: -28.3 
   Deselect: Use top value for both 
 Menu: Conditions -> Observation Points 
 Button: "Insert" 
 Insert 4 observation nodes, one every 25 cm 
 Menu: File -> Save Data 
 Menu: File –> Exit 
 
Soil Profile – Summary 
 Button: "OK" 
 
Solute Transport – HP1 definitions 
 
 Geochemical Model 
 

Button: "Exchange" 
Add for each layer the cation exchange complex X with its size in mol/1000cm³ of 
soil. 
Equilibrate each cation exchange complex with the corresponding initial solution for 
a particular soil layer (i.e., 1001 to 1007) 
 

EXCHANGE 1-7 @Layer 1@ 
X 0.216 
-equilibrate with solution 1001 
 
EXCHANGE 8-19 @Layer 2@ 
X 0.072 
-equilibrate with solution 1002 
 
EXCHANGE 20-24 @Layer 3@ 
X 0.384 
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-equilibrate with solution 1003 
 
EXCHANGE 25-28 @Layer 4@ 
X 0.312 
-equilibrate with solution 1004 
 
EXCHANGE 29-50 @Layer 5@ 
X 0.075 
-equilibrate with solution 1005 
 
EXCHANGE 51-76 @Layer 6@ 
X 0.011 
-equilibrate with solution 1006 
 
EXCHANGE 77-101 @Layer 7@ 
X 0.007 
-equilibrate with solution 1007 

 
Button: "OK" 
 

Button: "OK" 
 
Run Application 
 
 

4.6.5 Output 
 
Time series of Cl, Ca, and Cd at selected depths are shown in Figure 23. Cd concentration 
increases when Cl concentration increases due to aqueous complexation between Cd2+ and Cl-.  
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Figure 23 – Time series of Cl (top left), Ca (top right), and Cd (bottom) concentrations at selected depths 
(observation nodes) for the example described in section 0. 
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4.7 Horizontal Infiltration of Multiple Cations and Cation Exchange 
 

4.7.1 Problem Definition 
 
This exercise simulates horizontal infiltration of multiple cations (Ca, Na, and K) into the 
initially dry soil column. It is vaguely based on experimental data presented by Smiles and Smith 
[2004]. The cation exchange between particular cations is described using the Gapon exchange 
equation [White and Zelazny, 1986]. For an exchange reaction on an exchange site X involving 
two cations N and M with charge n and m: 
 

  N1/nX + 1/m M  = M1/mX + 1/n N     (2) 
 
 
the Gapon selectivity coefficient KGMN is: 
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where [] denotes activity. The activity of the exchange species is equal to its equivalent fraction. 
The Gapon selectivity coefficients for Ca/Na, Ca/K, and Ca/Mg exchange are KGCaNa = 2.9, 
KGCaK = 0.2, and KGCaMg = 1.2. It is assumed that the cation exchange capacity Tc  (molckg-1 soil) 
is constant and independent of pH.  
 
Consider a soil column 20-cm long with an initial water content of 0.075. Infiltration occurs on 
the left side of the column under a constant water content equal to the saturated water content. 
Consider a free drainage right boundary condition. 
 
Some physical parameters of the column are: bulk density = 1.75 g/cm³; dispersivity = 10 cm; 
the soil water retention characteristic and unsaturated hydraulic conductivity curve are described 
with the van Genuchten – Mualem model with the following parameters: θs = 0.307, θr = 0, α = 
0.259 cm-1, n = 1.486, Ks = 246 cm/day, and l = 0.5. The CEC is 55 meq/kg soil. 
 
As initial concentrations take: [Cl] = 1 mmol/kg water, [Ca] = 20 mmol/kg water, [K] = 2 
mmol/kg water, [Na] = 5 mmol/kg water, [Mg] = 7.5 mmol/kg water, and [C(4)] = 1 mmol/kg 
water. The pH is 5.2, and the solution contains an unknown concentration of SO4

2- as a major 
anion. The inflowing solution has the following composition: [Ca] = 0.002345 mol/kg water, 
[Na] = 0.01 mol/kg water, [K] = 0.0201 mol/kg water, [Mg] = 0, and [Cl] = 0.035 mol/kgw. The 
pH is 3.2, and the solution contains an unknown concentration of SO4

2- as major anion. 
 
Look at profile data of the water content, pH, concentrations of the cations and anions, and the 
amount of sorbed cations. Express sorbed concentration in meq/kg soil. 
 

4.7.2 Definition of the Geochemical Model and its Parameters 
 

1. The CEC should be expressed in mol/1000 cm3 of soil in HP1. Recalculate the amount of 
CEC. 
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       [Answer: 0.09625 mol/1000 cm³ soil] 
 

2. Define the thermodynamic data for describing the exchange process with the Gapon 
convention and the Gapon selectivity coefficients. 
 
A new master exchange species have to be defined, say G. 
 
The exchange reactions (Eq. 2) have to be written in terms of half reactions: 
 

G- + K+ = KG  (4) 
G- + Na+ = NaG  (5) 
G- + 0.5 Ca+2 = Ca0.5G  (6) 
G- + 0.5 Mg+2 = Mg0.5G  (7) 

 
with appropriate values of the exchange coefficients. Thus, log KGK, log KGNa, log KGCa, 
and log KGMg are needed for equations 4, 5, 6, and 7, respectively. It is assumed that the 
KG value for the half reaction with Na is 1, i.e. log KGNa = 0.0. The thermodynamic 
constants for the other half reactions are then calculated from the defined Gapon 
selectivity coefficients relative to KGNa. 
 
Calculate log KGK, log KGCa, and log KGMg. 
 
Solution:  
 

Exchange reactions are written in terms of half reactions. The reaction:  
 
    Na-G + 0.5 Ca2+ = Na+ + Ca0.5-G  KGCaNa 

 
is written as the sum of the half reactions: 
 

    (1) G- + Na+ = Na-G   KGNa 
   (2) G- + 0.5 Ca2+ = Ca0.5-G  KGca 
 
Consequently: 
 

       log(KCaNa) = log(KGCa) - log(KGNa) 
 

 We express the exchange coefficients relative to Na+. Thus, taking log(KGNa) equal to 
0, log(KGCa) = log(KGCaNa). Similarly, for the reaction: 

 
     K-G + 0.5 Ca2+ = K+ + Ca0.5-G KGCaK 

 
the following two half reactions can be written as: 
 

    (1) G- + K+ = K-G   KGK 
   (2) G- + 0.5 Ca2+ = Ca0.5-G  KGca 
 
Then, log(KGCaK) = log(KGCa) - log(KGK). And similarly, log(KGK) = log(KGCa) - 
log(KGCaK). The same reasoning is applied also to derive KGMg. 
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[Answer: log KGK = 1.16            
log KGCa = 0.462 

log KGMg = 0.383] 
 

4.7.3 Input 
 
Project Manager 

Button "New" 
Name: CEC-4 
Description: Horizontal infiltration with Cation Exchange 
Button "OK" 
 

Main Processes 
Heading: Horizontal infiltration with Cation Exchange 
Check "Water Flow" 
Check "Solute Transport"  
Select “HP1 (PHREEQC)” 
Button “Next” 
 

Geometry Information 
Depth of the soil profile: 20 (cm) 
Decline from vertical axes: 0 (horizontal flow) 
Button “Next” 

 
Time Information 

Time Units:   Minutes 
Final Time:   144 (min) 
Initial Time Step:  0.01 (min) 
Minimum Time Step: 0.01 (min) 
Maximum Time Step: 2 
Button “Next” 
 

Print Information 
Number of Print Times: 6 
Button "Select Print Times" 
Button "Default(log)" 
Button “Next” 
 

HP1 – Print and Punch Controls 
   Select: Make GNUPLOT templates 

Button: "Next 
 

Water Flow - Iteration Criteria 
Lower Time Step Multiplication Factor: 1.3 
Button “Next” 

 
Water Flow - Soil Hydraulic Model 

Button “Next” 
 
Water Flow - Soil Hydraulic Parameters 
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Catalog of Soil Hydraulic Properties: Loam 
Qr: 0 
Qs: 0.307 
Alpha: 0.259 (cm-1) 
n: 1.486 
Ks: 0.170833 (cm/min) 
Button “Next” 

 
Water Flow - Boundary Conditions 
   Initial Condition: in Water Contents 

Upper Boundary Condition: Constant Water Content 
Lower Boundary Condition: Free Drainage 
Button “Next” 

 
Solute Transport - General Information 

Number of Solutes: 9 
Button “Next” 

 
Solute Transport – HP1 Components and Database Pathway 
 Add the nine components: Total_O, Total_H, Ca, Na, K, Mg, Cl, C(4), S(6) 
 Check: "Create PHREEQC.IN file using HYDRUS GUI" 
 Button: “Next” 
 
Solute Transport – HP1 Definitions 
 
 Additions to Thermodynamic Database 
 

• Define the master exchange species G 
• Define the master species. An identical reaction for the master exchange 

species has to be included. 
 

EXCHANGE_MASTER_SPECIES 
G G- 
 
EXCHANGE_SPECIES 
G- = G-; log_k 0 
G- + K+ = KG; log_k 1.16 
G- + Na+ = NaG; log_k 0 
G- + 0.5 Ca+2 = Ca0.5G; log_k 0.462 
G- + 0.5 Mg+2 = Mg0.5G; log_k 0.383 

 
Button: "OK" 
 

 Definitions of Solution Compositions 
 

• Define the initial solution as solution 1001 
• Define the boundary solution as solution 3001 
• Assume that the solutions are in equilibrium with the atmospheric partial 

pressure of oxygen and carbon dioxide 
 

solution 1001 initial solution 
pH 5.2 
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Cl 1 
Ca 20 
K 2 
Na 5 
Mg 7.5 
C(4) 1 CO2(g) -3.5 
O(0) 1 O2(g) -0.68 
S(6) 1 charge 
 

solution 3001 boundary solution 
pH 3.2 
Ca 2.345 
Na 10 
K 20 
Cl 35 
C(4) 1 CO2(g) -3.5 
O(0) 1 O2(g) -0.68 
S(6) 1 charge 

 
Button: "OK" 

 
Geochemical Model 

 
• Define an exchange assemblage for 101 nodes 
• Equilibrate the exchange sites with the initial solution 

 
Exchange 1-101 
G 0.09625 
-equilibrate with solution 1001 

 
Button: "OK" 

 
Additional Output 
 

• Add SELECTED_OUTPUT to ask for output of total concentrations of the 
components 

• Add USER_PUNCH to save the absorbed concentrations as meq/kg soil. The 
default output in HP1 for an exchange species is mol/kg water. This can be 
asked by –molalities NaG in SELECTED_OUTPUT or as a BASIC 
statement (10 punch mol("NaG")) in USER_PUNCH. BASIC statements to 
convert 'mol/kg water' to 'meq/kg soil' can be added to USER_PUNCH. The 
following two variables are needed: 

o The bulk density: use the HP1-specific BASIC statement 
bulkdensity(number), where number is the cell number of a given 
node, to obtain the bulk density for a given node. The number of the 
cell is obtained by the BASIC statement cell_no. 

o The water content: obtained as tot("water"). 
• Add meaningful headings for the punch output. 

 
 

SELECTED_OUTPUT 
 -totals Cl Ca K Na Mg S 
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USER_PUNCH 
-headings Sorbed_Ca@meq/kg_soil Sorbed_Mg@meq/kg_soil   
Sorbed_Na@meq/kg_soil Sorbed_K@meq/kg_soil 
-start 
 10 bd = bulkdensity(cell_no) #kg/1000cm³ soil 
 40 PUNCH mol("Ca0.5G")*tot("water")/bd*1000 #in meq/kg 
 50 PUNCH mol("Mg0.5G")*tot("water")/bd*1000 #in meq/kg 
 60 PUNCH mol("NaG")   *tot("water")/bd*1000 #in meq/kg 
 70 PUNCH mol("KG")    *tot("water")/bd*1000 #in meq/kg 

-end 
 

Button: "OK" 
 

Button: “Next” 
 

Solute Transport – Solute Transport Parameters 
Bulk Density: 1.75 (g/cm³) 
Disp: 10 (cm) 
Button “Next” 

 
Solute Transport - Boundary Conditions 

Upper Boundary Condition:  Concentration Flux 
Bound. Cond.: 3001  
Lower Boundary Condition:  Zero Gradient 
Button “Next” 

 
 
Soil Profile - Graphical Editor 
 Menu: Conditions -> Initial Conditions -> Water content 
 Button: "Edit Condition" 
   Select All 
   Top Value: 0.075  
 Button: "Edit Condition" 
   Select first node 
   Value: 0.307 
 Menu: Conditions -> Observation Points 
 Button: "Insert" 
 Insert 4 observation nodes at 3, 6, 9, and 12 cm 
 Menu: File -> Save Data 
 Menu: File –> Exit 
 
Soil Profile - Summary 

Button “Next” 
 
Run Application 
 

4.7.4 Output 
 
Explore the HYDRUS output and the GNUPLOT templates. 
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Figure 24 – Profiles of water content (top left), and total aqueous concentrations of Cl, Na, K, Ca and 
Mg at selected print times during horizontal infiltration of multiple cations (the example is described 
in section 4.7). 
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Figure 25 – Profiles of sorbed concentrations of Na, K, Ca, and Mg at selected print times during 
horizontal infiltration of multiple cations (the example is described in section 4.7). 



 

 

72 

4.8 U Transport and Surface Complexation 
 

4.8.1 Problem definition 
 
This exercise simulates the leaching of U under saturated, steady-state flow conditions. U 
adsorbs on Fe-oxides in the soil profile. 
 
Consider a 50-cm deep loamy soil with a saturated hydraulic conductivity of 1 cm/day. Take a 
porosity of 0.43, a bulk density of 1.31 g/cm³, and a dispersivity of 1 cm. The Fe2O3 content of 
the soil is 0.02 weight percentage. The capacity of the surface is calculated assuming that Fe2O3 
has 0.875 reactive sites per mole of Fe (Waite et al., 1994). 
 
Following elements are considered: Ca, Cl, K, Mg, Na, U(6), and C(4). In this geochemical 
transport problem that is pH-sensitive, also Total_O and Total_H need to be transported. U 
adsorption is described by a non-electrostatic surface complexation model. As a consequence of 
this, a charge on the solid surface is not balanced by counter-ions in a double layer near the 
surface. Therefore, the aqueous phase will have a charge imbalance that will be of the same size, 
but having an opposite sign, as the charge on the surface. The entire system (i.e., solid surface + 
aqueous phase) will then be charged balanced. Therefore, also the 'Charge' of the aqueous 
solution has to be transported. Note that when an electrostatic surface complexation model, 
which takes into account the composition of the double layer, is used, the aqueous phase will be 
charged balanced, and so will be the solid surface and the double layer. 
 
A solution composition of rain water is assumed for both initial and boundary conditions: [Cl] = 
69 µmol/kg water, [Ca] = 6 µmol/kg water, [K] = 4 µmol/kg water, [Na] = 64 µmol/kg water, 
[Mg] = 8 µmol/kg water. The concentration of O2 and CO2 are assumed to be in equilibrium with 
the atmospheric partial pressure of O2(g) and CO2(g). The U concentration in the initial solution 
composition is considered to be very low ([U] = 10-24 M), and much larger (10-7 M) in the 
boundary solution. 
 
This problem is carried out using the PHREEQCU.DAT database. This is the PHREEQC.DAT 
database with the definition of additional U-species (from Langmuir, 1997 – a database from 
www.geo.tu-freiberg.de/~merkel/Wat4f_U.dat). Sorption is described using solid complexation 
reactions on the surface site called Hfo_w (line 3448 in the database). Solution complexation 
species are defined further in the database. Note that only one U-species adsorbs (uranyl): 
 

Hfo_wOH + UO2+2 = Hfo_wOUO2+ + H+ 
  log_k  2.8 

 

4.8.2 Calculation of the Size of the Surface Sorption Site 
 
The capacity of the surface should be expressed in mol/1000 cm³ of soil. The capacity is 
calculated as: 
 
(0.0002) [g Fe2O3/g soil] * 1.31 [g soil/cm3] * (1/160) [mol Fe2O3/g Fe2O3] * 2 [mol Fe/mol 
Fe2O3] * 0.875 [moles sites/mol Fe ] * 1000 [cm³/1000cm³] = 0.00286 mol/1000 cm³ 
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4.8.3 Input 
 
Project Manager 
 Button: "New" 
 Name: "UTransport" 
 Description: "U transport and complexation" 
 Button: "OK" 
 
Main Processes 
 Heading: U transport and complexation 
 Uncheck: "Water Flow" (steady state saturated water flow) 
 Check: "Solute Transport" 
 Select: "HP1 (PHREEQC)" 
 Button: “Next” 
 
Geometry Information 
 Depth of the Soil Profile: 50 (cm) 
 Button: “Next” 
 
Time Information 
 Final Time: 200 (days) 
 Button: “Next” 
 
Print Information 
 Unselect: T-Level information 
 Select: Print at Regular Time Interval 
 Time Interval: 0.025 (days) 
 Print Times: Number of Print times: 5 
 Button: “Next” 
 
Print Times 
 Button: "Default" 
 Button: "OK" 
 
HP1 – Print and Punch Controls 
 Check: "Make GNUplot Templates" 

Button: “Next” 
 
Water Flow – Iteration Criteria 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Model 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Parameters 
 Qs: 0.43 
 Ks: 1 (cm/day) 
 Button: “Next” 
 
Water Flow – Boundary Conditions 
 Upper Boundary Condition: Constant Pressure Head 
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 Lower Boundary Condition: Constant Pressure Head 
 
Solute Transport – General Information 
 Stability Criteria: 0.25 
 Number of Solutes: 11 
 Button: “Next” 
 
Solute Transport – HP1 Components and Database Pathway 
 Database Pathway: 
  Browse: phreeqcU.dat  
 Eleven Components: Total_O, Total_H, Charge, Ca, Cl, Mg, Na, K, C(4), U(6), and U(5) 
 Check: "Create PHREEQC.IN file using the HYDRUS GUI" 
 Button: “Next” 
 
Solute Transport – HP1 Definitions 
 
 Definitions of Solution Compositions 
 

Define the initial condition 1001: 
• Rain water without U 
• Use the pH to obtain charge balance of the solution 
• Put C and O in equilibrium with the atmospheric partial pressure of 

oxygen and carbon dioxide, respectively 
 
Define the boundary condition 3001:  

• Rain water with U 
• Use the pH to obtain charge balance of the solution 
• Put C and O in equilibrium with the atmospheric partial pressure of 

oxygen and carbon dioxide, respectively 
 

solution 1001 
-ph 7 charge 
-pe  15.2939 
-units mol/kgw 
C 1 CO2(g) -3.5 
Ca 6E-6 
Cl 69E-6 
K 4E-6 
Mg 8E-6 
Na 64E-6 
O(0) 1 O2(g) -0.68 

 
solution 3001 rain water 
-ph 7 charge 
-pe  15.2939 
-units mol/kgw 
C 1 CO2(g) -3.5 
Ca 6E-6 
Cl 69E-6 
K 4E-6 
Mg 8E-6 
Na 64E-6 
O(0) 1 O2(g) -0.68 
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U(6) 1E-7 
 

  Button: "OK" 
 
 Geochemical Model 
 

• Define the surface complexation assemblage for 101 nodes 
• Add identifier –no_edl  
• Equilibrate the exchange sites with the initial solution 

 
Surface 1-101 
 Hfo_w 0.00287 
 -no_edl 
 -equilibrate with solution 1001 

 
  Button: "OK" 
 
 Additional Output 
 

Define the additional output to be written to selected output files.  
 

selected_output 
  -totals U 
 
user_punch 
-headings Adsorbed_U@mol/kg Percentage_adsorbed_U@- 
log(Kd) 
-start 
 10 Usorbed = 
mol("Hfo_wOUO2+")*tot("water")/bulkdensity(cell_no) 
 20 PUNCH Usorbed 
 30 if (SYS("U(6)")>0) then percentage = 
mol("Hfo_wOUO2+")*tot("water") / SYS("U(6)") * 100 
else percentage = 0 
 40 if (SYS("U(6)")>0) then Kd = log10(Usorbed / 
tot("U(6)")) else Kd = -9999 
 50 PUNCH percentage Kd 
-end 

  Button: "OK" 
 

Button: “Next” 
 

Solute Transport – Solute Transport Parameters 
 Bulk density: 1.31 (g/cm³) 
 Disp:  1 cm (cm) 
 Button: “Next” 
 
Solute Transport – Boundary conditions 
 Upper Boundary Condition  Bound. Cond. 3001 
 
Soil Profile – Graphical Editor 
 Menu: Conditions -> Initial Conditions -> Pressure Head 
 Button: "Edit Condition" 
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   Select All 
   Top Value : 0 
 Menu: Conditions -> Observation Points 
  Button: "Insert" 
  Insert 5 observation nodes: add observation nodes at 0.5, 2, 5, 15, 25 and 50 cm
 Menu: File -> Save Data 
 Menu: File –> Exit 
 
Soil Profile – Summary 
 Button: “Next” 
 
Run Application 
 

4.8.4 Output 
 
U-profiles at selected print times are shown in Figure 26. 
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Figure 26 – Profiles of aqueous concentration of U for the example described in section 4.8. 
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4.9 First-Order Kinetic PCE Degradation Network 
 

4.9.1 Background 
 
Perchloroethylene (PCE, also called tetrachloroethylene) degrades slowly under reducing 
conditions, mainly due to microbiological transformations. One of the most important pathways 
for anaerobic biodegradation of PCE is by reductive dechlorination in a sequential way. Figure 
27 (after Schaerlaekens et al., 1999) shows this pathway for six components: PCE, 
trichloroethylene (TCE), cis-1,2-dichloroethylene (cis-DCE), trans-1,2-dichloroethylene (trans-
DCE), 1,1-dichloroethylene (1,1-DCE), and vinyl chloride (VC). VC then eventually degrades to 
ethylene (ETH), which is environmentally acceptable and does not cause direct health effects.  
 
Although the reaction kinetics of the biodegradation depend on a variety of environmental 
conditions (such as redox potential, biomass, and compounds affecting solubility), the kinetics 
here is described independently of environmental conditions.  
 
When the DCE (dichloroethylene) species are lumped, the transport problem can be formulated 
as a transport of a single sequential degradation chain, which can then be solved directly using 
HYDRUS-1D (e.g., Schaerlaekens et al., 1999; Casey and Šimůnek, 2001; see also one of the 
HYDRUS-1D tutorials). However, the HP1 code can handle the full reaction network as defined 
in Figure 28 (i.e., with three separate DCE species), while considering different distribution 
factors α and yield coefficients γ. 
 
 
 

 

 
 
Figure 27 – Perchloroethylene (PCE) degradation pathway. (Figure from Schaerlaekens et al., 
1999). 
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4.9.2 Problem Definition 
 
In this example, we will simulate the transport and degradation of PCE and its daughter products 
in a soil column. Degradation not only occurs as sequential reactions, but also partly as parallel 
degradation reactions (see Figure 28). Degradation coefficients, yield factors and distribution 
factors are given in Table 9. 
 
Saturated flow conditions in a 2.0 m long soil column are maintained for 150 days. The 
inflowing solution contains only 10 mmol of PCE/kg of water.  
     
Physical properties of the soil are a porosity of 0.5, the saturated hydraulic conductivity of 1 
cm/day, and a dispersivity of 10 cm. Other soil hydraulic parameters are irrelevant for saturated 
conditions.  
 

4.9.3 Input 
 

Table 9 Definition of parameters and their values for the PCE biodegradation problem 
(from Case 1 and 2 in Sun et al., 2004). Rate parameters are for a reference temperature of 
20°C. 

  
Parameter Symbol Values 

 
Unit 

  Verification  
Velocity 
Dispersion coefficient 
First-order degradation rate 1 
First-order degradation rate 2 
First-order degradation rate 3 
First-order degradation rate 4 
First-order degradation rate 5 
First-order degradation rate 6 
First-order degradation rate 7 
Distribution factor, TCE to cis-DCE 
Distribution factor, TCE to trans-DCE
Distribution factor, TCE to 1,1-DCE 
Yield coefficient, PCE to TCE 
Yield coefficient, TCE to DCE 
Yield coefficient, DCE to VC 
Yield coefficient, VC to ETH 

v 
D 
k1 
k2 
k3 
k4 
k5 
k6 
k7 
α1 
α2 
α3 
y1 
y2 
y3 
y4 

0.4 
0.4 
0.075 
0.070 
0.020 
0.035 
0.055 
0.030 
0.000001 
0.72 
0.15 
0.13 
0.79 
0.74 
0.64 
0.45 

m d-1 
m² d-1 
d-1 
d-1 
d-1 
d-1 
d-1 
d-1 
d-1 
- 
- 
- 
- 
- 
- 
- 

 

PCE TCE
k1 , y1 k2 , y2

cis-DCE

trans-DCE

1,1-DCE

α1

α2

α3

k3

k4

k5

y3
VC ETH

k6 , y4 k7 

 
 
Figure 28 – Degradation pathway of PCE using first-order rate constants. 
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Project Manager 
 Button: "New" 
 Name: "TCE-1" 
 Description: "TCE first-order degradation network" 
 Button: "OK" 
 
Main Processes 
 Heading: TCE first-order degradation network 
 Uncheck: "Water Flow" (steady-state saturated water flow) 
 Check: "Solute Transport" 
 Select: "HP1 (PHREEQC)" 
 Button: “Next” 
 
Geometry Information 
 Depth of the Soil Profile: 200 (cm) 
 Button: “Next” 
 
Time Information 
 Final Time: 150 (days) 
 Initial Time Step: 1E-5 (days) 
 Minimum Time Step: 1E-5 (days) 
 Maximum Time Step: 0.25 (days) 
 Button: “Next” 
 
Print Information 
 Unselect: T-Level information 
 Select: Print at Regular Time Interval 
 Time Interval: 1 (day) 
 Print Times: Number of Print times: 5 
 Button: “Next” 
 
Print Times 
 Button: "Default" 
 Button: "OK" 
 
HP1 – Print and Punch Controls 
 Check: "Make GNUplot Templates" 

Button: “Next” 
 
Water Flow – Iteration Criteria 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Model 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Parameters 
 Qs: 0.5 
 Ks: 1 (cm/days) 
 Button: “Next” 
 
Water Flow – Boundary Conditions 
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 Upper Boundary Condition: Constant Pressure Head 
 Lower Boundary Condition: Free drainage 
 
Solute Transport – General Information 
 Stability Criteria: 0.25 
 Number of Solutes: 9 
 Button: “Next” 
 
Solute Transport – HP1 Components and Database Pathway 
 Six Components: Total_O, Total_H, Pce, Tce, Dcecis, Dcetrans, Dceee, Vc, and Eth 
 Check: "Create PHREEQC.IN file using HYDRUS GUI" 
 Button: “Next” 
 
Solute Transport – HP1 Definitions 
 
 Additions to Thermodynamic Database 
 
  Define new solution master species 
  Define new solution species 
  Define Rate equations 
 

SOLUTION_MASTER_SPECIES 
    Pce           Pce          0     Pce             1 
    Tce           Tce          0     Tce             1 
    Dcecis        Dcecis       0     Dcecis          1 
    Dcetrans      Dcetrans     0     Dcetrans        1 
    Dceee         Dceee        0     Dceee           1 
    Vc            Vc           0     Vc              1 
    Eth           Eth          0     Eth             1 
 
SOLUTION_SPECIES 
 Pce = Pce ; log_k 0.0 
 Tce = Tce ; log_k 0.0 
 Dcecis = Dcecis ; log_k 0.0 
 Dcetrans = Dcetrans ; log_k 0.0 
 Dceee = Dceee ; log_k 0.0 
 Vc = Vc ; log_k 0.0 
 Eth = Eth ; log_k 0.0 
 
RATES 
 
PCEdegrad 
-start 
 10 REM par1 = k 
 20 rate = parm(1)*TOT("water")*MOL("Pce") 
 30 moles = - rate * TIME 
 40 SAVE moles 
-end 
 
TCEdegrad 
-start 
 10 REM par1 = k 
 20 rate = parm(1)*TOT("water")*MOL("Tce") 
 30 moles = - rate * TIME 
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 40 SAVE moles 
-end 
 
DCEcisdegrad 
-start 
 10 REM par1 = k 
 20 rate = parm(1)*TOT("water")*MOL("Dcecis") 
 30 moles = - rate * TIME 
 40 SAVE moles 
-end 
 
DCEtransdegrad 
-start 
 10 REM par1 = k 
 20 rate = parm(1)*TOT("water")*MOL("Dcetrans") 
 30 moles = - rate * TIME 
 40 SAVE moles 
-end 
 
DCEeedegrad 
-start 
 10 REM par1 = k 
 20 rate = parm(1)*TOT("water")*MOL("Dceee") 
 30 moles = - rate * TIME 
 40 SAVE moles 
-end 
 
VCdegrad 
-start 
 10 REM par1 = k 
 20 rate = parm(1)*TOT("water")*MOL("Vc") 
 30 moles = - rate * TIME 
 40 SAVE moles 
-end 
 
ETHdegrad 
-start 
 10 REM par1 = k 
 20 rate = parm(1)*TOT("water")*MOL("Eth") 
 30 moles = - rate * TIME 
 40 SAVE moles 
-end 

 
 Definitions of Solution Compositions 
 

Define the initial condition 1001:  
• Pure water 

 
Define the boundary condition 3001:  

• Pce concentration 
 

solution 1001 initial solution 
 
solution 3001 boundary solution 
Pce 10 
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  Button: "OK" 
 
 Geochemical Model 
 

Define for each node the geochemical model, i.e., KINETIC keywords: 
 

KINETICS 1-101 @Layer 1@ 
PCEdegrad 
 -formula Pce 1.0 Tce -0.79 
 -parms 0.075 
TCEdegrad 
 -formula Tce 1.0 Dcecis -0.5328 Dcetrans -0.111 Dceee -
0.0962 
 -parms 0.070 
DCEcisdegrad 
 -formula Dcecis 1.0 Vc -0.64 
 -parms 0.020 
DCEtransdegrad 
 -formula Dcetrans 1.0 Vc -0.64 
 -parms 0.035 
DCEeedegrad 
 -formula Dceee 1.0 Vc -0.64 
 -parms 0.055 
VCdegrad 
 -formula Vc 1.00 Eth -0.45 
 -parms 0.030 
ETHdegrad 
 -formula Eth 1.00 
 -parms 0.000001 

 
  Button: "OK" 
 
 
 Additional Output 
 

Define the additional output to be written to selected output files.  
 

selected_output 
 -totals Pce Tce Dcecis Dcetrans Dceee Vc Eth 

 
  Button: "OK" 
 

Button: “Next” 
 

Solute Transport – Solute Transport Parameters 
         Bulk density: 1.5 (g/cm³) 
 Disp:  10 (cm) 
 Button: “Next” 
 
Solute Transport – Boundary conditions 
 Upper Boundary Condition  Bound. Cond. 3001 
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Soil Profile – Graphical Editor 
 Menu: Conditions -> Initial Conditions -> Pressure Head 
 Button: "Edit Condition" 
   Select All 
   Top Value: 0 
 Menu: Conditions -> Observation Points 
 Button: "Insert" 
 Insert 5 observation nodes, one every 50 cm 
 Menu: File -> Save Data 
 Menu: File –> Exit 
 
Soil Profile – Summary 
 Button: “Next” 
 
Run Application 
 

4.9.4  Output 
 
Time series, profiles, and outflow curves are shown in Figure 29, Figure 30, and Figure 31, 
respectively. 
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Figure 29 – Time series of Dcecis (left) and Vc (righ ) at selected depths (observation nodes) for the 
example described in section 4.9. 
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Figure 30 – Profiles of Tce (left) and Eth (righ ) at selected print times for the example described in 
paragraph 4.9. 
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Figure 31 – Outflow curves for the example described in section 4.9. 

 



 

 

85

4.10 First-Order Kinetic PCE Degradation Network: Leaching of Initial PCE Source 
 

4.10.1 Background and Problem Definition 
 
In this example, the boundary condition problem described in paragraph 4.9 is changed to an 
initial condition problem. It is assumed that the top 50 cm of the soil profile is contaminated with 
PCE. We assume that the amount of non-aqueous (immobile) PCE is 0.01 mol/1000 cm³ of soil. 
Knauss et al. (2000) reported the following partial molal thermodynamic quantities for the PCE 
liquid aqueous dissolution reaction: 
 

∆rHº = -1790 J/mol     (8) 
 

∆rSº = -59 J/mol K     (9) 
 

∆rCpº = -354.6 J/mol     (10) 
 
 
where R is the gas constant (8.31441 J/mol), and ∆rHº, ∆rSº, and ∆rCpº are the change of entropy, 
enthalpy, and heat capacity of reaction at standard conditions (T0 = 298 K). The following 
equation is used in PHREEQC to define the temperature dependence of solubility constants 
(Parkhurst and Appelo, 1999): 

2
5

4
3

21 T
A)Tlog(AT

ATAA)Klog( ++++=                          (11) 

 
Temperature dependence of the solubility coefficient can be described with a three-term 
extrapolation expression with coefficients A1, A3, and A4 using the following relations 
(Puigdomènech et al., 1997): 
 

  ( )[ ]1ln∆∆
303.2
1

01 +−°= ° TCS
R

A prr      (12) 

 
( )03 ∆∆

303.2
1 TCH
R

A prr
°−°−=       (13) 

 
( )10ln∆

303.2
1

4
°= prCR

A       (14) 

 
Calculate coefficients A1, A3, and A4: 

           
 [Answer: A1 = -127.10 

A2 = 5612  
A4 = 42.64] 

 

4.10.2 Input 
 
Project Manager 
 Select project: "TCE-1" 



 

 

86 

 Button: "Copy" 
 New Name: "TCE-2" 
 Description: " TCE first-order degradation network: initial value problem" 
 Button: "OK" 
 
Main Processes 
 Heading: TCE first-order degradation network: initial value problem 
 Button: "OK" 
 
Solute Transport – HP1 Definitions 
  
 Addition to Thermodynamic Database 
 

Add the definition of the solid phase TCE 
 

PHASES 
 
 PCE_lq 
  Pce = Pce 
    -analytical_expression -127.10 0 5612 42.64 0 

 
 Definitions of Solution Compositions 
 

 Define an initial solution 1002 in equilibrium with the PCE_lq phase 
 Define a pure water boundary solution 
 

solution 1002 initial solution top layer 
 Pce 1 Pce_lq 0 
 
solution 3001 boundary solution 

 
  Button: "OK" 
 
 Geochemical Model 
 

Add initial pollution in the top 50 cm 
 

Equilibrium_phases 1-26 
 PCE_lq 0 0.01 

 
  Button: "OK" 
 
 Additional Output 
 

Add PCE_lq to –equilibrium_phases 
 

selected_output 
-totals Pce Tce Dcecis Dcetrans Dceee Vc Eth 
-equilibrium_phases PCE_lq 

 
  Button: "OK" 
 

Button: "OK" 
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Soil Profile – Graphical Editor 
 
 Menu: Conditions -> Initial Conditions -> Concentrations 
 Concentration number: 1 
 Button: "Edit Condition" 
   Select nodes 1-26 
   Solution composition: 1002 
 Menu: File -> Save Data 
 Menu: File –> Exit 

 
Run Application 
 

4.10.3 Output 
 
Selected output is shown in Figure 32 and Figure 33. 
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Figure 32 – Profiles of the solid phase PCE_lq (left) and the aqueous concentrations of Pce (right) at 
selected print times for the example described in section 4.10. 
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Figure 33 – Outflow concentrations for the example described in section 4.10. 
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4.11 First-Order Kinetic PCE Degradation Network: Initial Source Trapped in 
Immobile Water Phase 
 

4.11.1 Problem Definition 
 
It is assumed that the solid PCE phase is trapped in immobile zones in the soil profile, instead of 
in the mobile aqueous phase as assumed in the example in section 4.10. Degradation reactions 
occur only in the mobile aqueous phase. Assume the following properties (in addition to those 
assigned in paragraph 4.10): the immobile water content: 0.1, the first-order exchange 
coefficient: 0.01 day-1. 
 

4.11.2 Input 
 
Project Manager 
 Select project: "TCE-2" 
 Button: "Copy" 
 New Name: "TCE-3" 
 Description: " TCE first-order degradation network: initial value problem MIM" 
 Button: "OK" 
 
Main Processes 
 Heading: TCE first-order degradation network: initial value problem MIM 
 Button: "OK" 
 
Solute Transport – General Information 
 
 Check: Dual-Porosity (Mobile-Immobile Water) Model (Physical nonequilibrium) 
 
Solute Transport – HP1 Definitions 
  
 Definitions of Solution Compositions 
 

 Delete solution 1002 
Add the initial solution for the immobile water phase in equilibrium with the PCE 
solid: 

 
solution 1001 initial solution mobile phase 
 
solution 2001 initial solution immobile phase 
 Pce 1 Pce_lq 0 
 
solution 3001 boundary solution 

 
  Button: "OK" 
 
 Geochemical Model 
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Add the PCE contamination in the top 50 cm in the immobile zone. Numbers for the 
immobile zone starts at numbers of node +1 and end at two times the number of 
nodes. For this project, numbers for the immobile zone are thus from 102 to 202. 
 

 
Equilibrium_phases 102-128 

      PCE_lq 0 0.01 
 

  Button: "OK" 
 

Button: "OK" 
 
Solute Transport – Transport Parameters 
 

Mass Tr.: 0.01 (day-1) 
ThImob: 0.1 
Button: "OK" 

 
Soil Profile – Graphical Editor 
 
 Menu: Conditions -> Initial Conditions -> Concentrations 
 Concentration number: 1 
 Button: "Edit Condition" 
   Select all 
   Solution composition: 1001 
 Menu: Conditions -> Initial Conditions -> Sorbed Concentrations 

Concentration number: 1 
 Button: "Edit Condition" 
   Select nodes 1-26 
   Solution composition: 2001 
 Button: "Edit Condition" 
   Select nodes 27-101 
   Solution composition: 1001 
 Menu: File -> Save Data 
 Menu: File –> Exit 

 
Run Application 
 

4.11.3 Output 
 
Selected output is shown in Figure 34 and Figure 35: 
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Figure 34 – Profiles of the solid phase PCE_lq (top), aqueous concentrations of Pce in the mobile (right) 
and immobile (right) water phases at selected print times for the example described in section 4.11. 
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Figure 35 – Outflow concentrations for the example described in section 4.11. 
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4.12 Coupled Nta Degradation and Biomass Growth 
 

4.12.1 Background 
 
The exercise is based on example 15 from the PHREEQC-2 manual (Parkhurst and Appel, 1999) 
and on the paper of Tebes-Stevens et al. (1998). The main topic is the biodegradation of 
nitrylotriacetate (Nta). 
 
The degradation of Nta, in presence of oxygen and biomass, is written as:  

+

+

++

=+++

432275

22
-2

0.424NH  CO3.12H  NOH0.576C

  H 2.424  OH 1.272  O 1.62  HNta    (15) 

 where HNta2- is C6H7O6N.  
 
A multiplicative Monod rate expression is used to describe the Nta degradation: 
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 = -qm Xm ⎟⎟
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where RHNTA2- is the rate of degradation [mol/l/hr], qm is the maximum specific rate (1.418E-3 
mol/g cells/hr), Xm is the biomass (initially 1.36E-4 g cells per liter of water), Ks is the half 
saturation constant for substrate (7.64E-7 mol/l) and Ka is the half saturation constant for 
acceptor (6.25e-6mol/l). 
 
The biomass production is described as: 

Rcells = -YRHNTa-2 - bXm      (17) 

 
where Rcells is the rate of cell growth [g cells/L/hr], Y is the microbial yield coefficient (65.14 g 
cells/mol Nta), and b is the first-order biomass decay coefficient (0.00208 hr-1).  
 
The two equations (16) and (17) are coupled: Eq. (16) needs the current amount of biomass, 
whereas Eq. (17) needs the biodegradation rate of Nta. PHREEQC Basic statements to be used in 
the rate equation allows for this coupling. 
 

4.12.2 Problem Definition 
 
Consider a column of 5 m. The porosity is 0.4. A constant water flux of 0.2 m/hr is applied under 
saturated steady-state flow conditions. The dispersivity is 5 cm and the bulk density is 1.5 g/cm³. 

The Nta concentration in the infiltrating water is 5.23 µmol/kgw. Both the initial and infiltrating 
water contain 0.49 µmol/kgw C, 31.25 µmol/kgw O2, 1000 µmol/kgw Na, and 1000 µmol/kgw 
Cl. Initially, there is 50 µg biomass per 1000 cm³ of soil. All other parameters are as defined 
above. 
 
Investigate time series and profile data of Nta and Biomass for an infiltration experiment of 24 
hr. 
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4.12.3 Input 
 
Project Manager 
 Button: "New" 
 Name: "Nta" 
 Description: "Nta degradation and biomass growth" 
 Button: "OK" 
 
Main Processes 
 Heading: Nta degradation and biomass growth 
 Check: "Water Flow" 
 Check: "Solute Transport" 
 Select: "HP1 (PHREEQC)" 
 Button: “Next” 
 
Geometry Information 
 Length Units: m 

Depth of the Soil Profile: 5 (m) 
 Button: “Next” 
 
Time Information 
 Time Units: Hours 
 Final Time: 24 (hours) 
 Button: “Next” 
 
Print Information 
 Unselect: T-Level information 
 Select: Print at Regular Time Interval 
 Time Interval: 0.025 
 Print Times: Number of Print times: 6 
 Button: “Next” 
 
Print Times 
 Button: "Default" 
 Button: "OK" 
 
HP1 – Print and Punch Controls 
 Check: "Make GNUplot Templates" 

Button: “Next” 
 
Water Flow – Iteration Criteria 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Model 
 Button: “Next” 
 
Water Flow – Soil Hydraulic Parameters 
 Qs: 0.4 
 Ks: 0.2 (m/hr) 
 Button: “Next” 
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Water Flow – Boundary Conditions 
 Upper Boundary Condition: Constant Pressure Head 
 Lower Boundary Condition: Constant Pressure Head 
 
Solute Transport – General Information 
 Stability Criteria: 0.25 
 Number of Solutes: 7 
 Button: “Next” 
 
Solute Transport – HP1 Components and Database Pathway 
 Database Pathway: 
  Browse: ex15.dat  

Six Components: Total_O, Total_H, C, Nta, Na, Cl, N 
 Check: "Create PHREEQC.IN file using HYDRUS GUI" 
 Button: “Next” 
 
Solute Transport – HP1 Definitions 
 
 Additions to Thermodynamic Database 
 
  Define rate equations 
 

RATES 
degradNTA 
-start 
 10 qm = parm(1)   
 20 Ks = parm(2) 
 30 Ka = parm(3) 
 40 Xm = kin("Biomass") 
 50 D = mol("HNta-2") / (Ks +mol("HNta-2")) 
 60 A = mol("O2") / (Ka +mol("O2")) 
 70 rate = -qm*Xm*D*A 
 80 moles = rate * time 
 90 put(rate,1) 
 100 SAVE moles 
-end 
 
Biomass 
-start 
 10 Y = parm(1) 
 20 b= parm (2)  
 30 degradNta = get(1) 
 40 rate = -Y*degradNta - b*M 
 50 moles = -rate*Time 
 60 if (M+moles) < 0  then moles = - M 
 70 SAVE moles 
-end 

 
 Definitions of Solution Compositions 
 

Define the initial condition 1001: 
Define the boundary condition 3001:  

 
solution 1001 
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pH 7 charge 
-units mol/kgw 
O(0)  6.25E-005 
C 4.9E-7 
Na 0.001 
Cl 0.001 
 
solution 3001 
pH 7 charge 
-units mol/kgw 
O(0)  6.25E-005 
C 4.9E-7 
Na 0.001 
Cl 0.001 
Nta 5.23E-6 

 
  Button: "OK" 
 
 Geochemical Model 
 

Define for each node the geochemical model, i.e., KINETICS keywords: 
 

kinetics 1-101 
degradNTA 
 -formula Nta 1. C -3.12 H -1.968 O -4.848 N -0.424 
 -parms 1.407E-3 7.64E-7 6.25e-6 
 
biomass 
 -formula H 0.0 
 -parms 65.14 0.00208 
 -m0 50E-6 
 

  Button: "OK" 
 
 Additional Output 
 

Define the additional output to be written to selected output files.  
 

SELECTED_OUTPUT 
 -totals Nta  
 -kinetics biomass 

 
  Button: "OK" 
 

Button: “Next” 
 

Solute Transport – Solute Transport Parameters 
 Disp:  0.05 (m) 
 Button: “Next” 
 
Solute Transport – Boundary conditions 
 Upper Boundary Condition  Bound. Cond. 3001 
 
Soil Profile – Graphical Editor 
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 Menu: Conditions -> Initial Conditions -> Pressure Head 
 Button: "Edit Condition" 
   Select All 
   Top Value: 0 
 Menu: Conditions -> Observation Points 
 Button: "Insert" 
 Insert 5 observation nodes at a depth interval of 1 m 
 Menu: File -> Save Data 
 Menu: File –> Exit 
 
Soil Profile – Summary 
 Button: “Next” 
 
Run Application 
 

4.12.4  Output 
 
Time series and profiles of selected variables are shown in Figure 36 and Figure 37. 
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Figure 36 – Time series of Nta concentrations and biomass at selected depths (observation nodes) for the 
example described in section 4.12. 
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Figure 37 – Profiles of Nta concentrations and biomass at selected print times for the example described 
in section 4.12. 
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